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Introduction
Introduction
This guide is intended to help you understand how each feature of Rich Media Desktop 
operates, and to provide you with information to help you make the best presentations 
possible.

Topics
 Editions and Options

 Tutorials

 Two Ways to Use this Application

 Using AutoLive

 Main Window Layout

 Layer Windows
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Editions and Options
Both editions of Rich Media Desktop (Rich Media Desktop and Rich Media Desktop Pro) 
are presented in this guide, and the term Rich Media Desktop is used, generally, to 
describe all major features. However, information that pertains specifically to Rich 
Media Desktop Pro is indicated by the Pro icon (shown below).

Rich Media Desktop provides support for Blackmagic capture cards, Mainconcept 
H264, and On2 VP6 Flash encoding. It also has an improved shot editor, many new 
titling options, and an enhanced user interface. 

Rich Media Desktop Pro provides Virtual Sets (a library of professionally designed 3D 
sets), a powerful Audio Inspector , IP camera support, aa networked real-time encoding 
and decoding device. Rich Media Desktop Pro also provides live scoreboards.

Note: If you don't have a Rich Media Desktop Pro license, Rich Media Desktop still 
enables you to experiment with Pro features, but all Rich Media Desktop Pro output is 
water-marked. Additionally, you can not save a document that has Pro features 
enabled.

PRO

PRO
February, 2012 RMD User Guide | 81707
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Tutorials
We suggest that you first work through the tutorials in Getting Started. They are quick, 
informative, and the easiest way to become familiar with Rich Media Desktop. 

Rich Media Desktop provides a built-in tutorial environment that corresponds with the 
tutorials provided in Getting Started. The tutorials take about thirty minutes and 
provide a brief overview of how to set up a basic presentation and create your own 
broadcast.

Next, we suggest that you read Making Great Presentations. This topic show you how 
you can easily make changes in your setup and make a huge difference in the quality of 
your presentations.
RMD User Guide | 81707 February, 2012
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Two Ways to Use this Application
There are two different ways you can use Rich Media Desktop:

• Presenter Is Operator. The person conducting the presentation also operates Rich 
Media Desktop.

• Presenter Plus Operator. The presenter concentrates on the content and someone 
else operates Rich Media Desktop. In this mode, the presenter never needs to know 
in detail how Rich Media Desktop works.

Presenter Is Operator
In this mode of operation, the person conducting the presentation simultaneously 
operates Rich Media Desktop.

Here are some suggestions for using Rich Media Desktop when you are both the 
presenter and operator:

• Keep it simple. Set up Rich Media Desktop to make it easy for you to be the operator 
and the presenter. Set up your logo and titles so that you need to make very few 
changes during your presentation. Use a minimum number of shots so it’s easy for 
you to see which shot to choose.

• Keep the AutoLive feature on. This enables you to present your shots with just one 
click. Though this limits your ability to perform complex presentations, it is the best 
way when the presenter is also the operator. To turn AutoLive on or off, select the 
Switch menu item.

• Pre-configure your shots. Make sure that all the shots are created prior to your pre-
sentation. Do not try to create or modify shots while broadcasting them.

• Use hot-keys for switching shots. If your shot has a number in it, you can press the 
Alt key plus that number’s key to immediately display the shot. For example, if you 
have a shot named “Me With Title 1”, press the Alt key and the 1 key to display this 
shot.

Presenter Plus Operator
In this mode of operation, an engineer (or operator) is responsible for using Rich Media 
Desktop, and the presenter concentrates on the content of the presentation. 

Here are some suggestions for using Rich Media Desktop when you have both an 
operator and a presenter:

• Keep the AutoLive feature off. This enables you to make several changes at one 
time before taking the changes live. However, to quickly make a shot live, press the 
Shift+Ctrl keys and click the shot.

• Open the Preview window. The operator should use Preview mode to examine 
everything before it becomes live.

• Use the Layer Windows to make more shots available. Select New Layer Window 
from the Window menu to open additional layer windows so you can quickly flip 
between shots on several layers.
February, 2012 RMD User Guide | 81707
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• Use the Inspector window to open and edit shots. The Inspector window acts 
exactly like the edit window but always edits the last shot you changed. To open the 
Inspector Window, click on the Window menu and select Inspector.
RMD User Guide | 81707 February, 2012
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Using AutoLive
Some users of Rich Media Desktop may want to single-click a shot to make it become 
live. Other users may want to make several changes to the broadcast before making 
them live. You can use both methods in Rich Media Desktop.

The AutoLive feature is designed to offer a single-click operation for those users who 
want to simply click from shot to shot. The Edit window (or other windows) is not 
affected by the status of AutoLive.

When AutoLive is on, clicking on a shot in the Main Window makes it become live. As a 
result, the Go button becomes useless, except for forcing a transition to run again. 
Shift+Ctrl+Click loads a shot into the preview but does not make it live.

When AutoLive is off, you click on a shot in the Main Window to display it in Preview, 
and the Go button is required to make a shot live. Click Shift+Ctrl+Click to take a shot 
live immediately.

Sometimes you may want to temporarily turn on and off (toggle) the AutoLive state. 
Hold down the Shift and control keys at the same time to temporarily turn on Autolive. 
This enables you to quickly switch AutoLive on for one action (i.e. a mouse-click), then 
off again.
February, 2012 RMD User Guide | 81707
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Main Window Layout
Rich Media Desktop is designed to be immediately usable with a few mouse clicks. 
However, after you understand more about how Rich Media Desktop works, you’ll 
probably want more flexibility.

Rich Media Desktop enables you to select which functions are displayed in the Main 
window. Most of these functions are added or removed from the main window using 
the Layout menu.

Figure 1. Main window Layout menu.

Preview
Preview displays what the broadcast will look like if you click the Go button. This is only 
useful when AutoLive is off. To display Preview, click the Layout menu and select 
Preview.

Figure 2. Preview window.

Layout menu

Preview window

Select menu 
Layout > Preview
RMD User Guide | 81707 February, 2012
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Master Audio
The Master Audio panel enables you to control the output volume level, mute audio 
output, and mute the line-out feed. To display Master Audio, click Layout > Master 
Audio.

Figure 3. Master Audio Panel

The Master Mute button controls the mute of the master audio (what your viewers 
hear). Even when you have muted the output, the encoder still generates audio, but it is 
silent. If you don’t want to broadcast audio, you should modify the Encoder Presets to 
not process audio through the encoder.

The Line-Out Mute button controls the what you hear locally. When line-out is mute, 
audio is not sent to your headphones or speakers, but your viewers will still hear it.

Main Shot List
Normally, the Main Window displays the shot list at the bottom of the window. 
However, you can hide the shot list display by selecting Main Shot List from the Layout 
Menu. This is useful if you want to open up multiple Shot List Layer windows.

Figure 4. Main window with Shot List turned off.

Master Volume control

Master Mute button

Line-Out Mute button

Select Layout > Main Shot List
February, 2012 RMD User Guide | 81707
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Output Statistics
You can display statistics about your broadcast, but they are only available while you 
are broadcasting. To display the Output Statistics panel, click Layer > Output Statistics.

Rich Media Desktop displays the following statistics:

• FPS Frames per second This value is controlled by the video part of your currently 
selected Encoder Presets. However, most encoders use this value as a target, not an 
exact limit. If this value consistently drops well below your target FPS, consider using 
a lower-quality video output to lower the bandwidth.

• CPU Usage (percentage) This represents the current load on your CPU. The encoder 
affects the CPU usage more than any other parameter in Rich Media Desktop. If this 
value is high, you should use a different encoder, or modify your encoder settings. If 
the CPU usage is near 95%, use a lower quality video output to lower the bandwidth.

• Data Rate This displays the current bandwidth used by your broadcast. This value is 
controlled by the video part of your currently selected Encoder Presets. Like frames 
per second, it is not always respected by the encoder. The encoder uses this value as 
a target, not an exact limit. Some encoders may (by design) exceed this limit.

• Time This displays how long you have been broadcasting. This value does not reset 
when you start/stop the broadcast, it is cumulative. This enables you to save por-
tions of a broadcast to disk and still know the total amount of time. In the example 
below, the presentation has been broadcasting for 5 minutes and 3 seconds:

Figure 5. Output Statistics Display

Layer Panel
To open the Layer Panel, select Layer Panel from the Layout menu at the top of the Main 
window. You can also open the Layer panel by hovering over the narrow grey panel on 
RMD User Guide | 81707 February, 2012
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the left side of the Shot Area until Rich Media Desktop displays a double arrow, then 
click and drag to the right until the Layer Panel displays: 

Figure 6. Two ways to open the Layer panel.

Here is what the Main Window looks like with the Layer Panel open:

Figure 7. Main window with Layer panel open.

Select Layout > Layer Panel

Click and drag to the right

Layer Panel
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Layer Windows
You can open the Shot List in a separate window. Select Window > New Layer Window 
to display the windows you can open. The figure below illustrates the Master Layer 1 
window when you open it as a separate layer: 

Figure 8. Master Layer 1 window.

This panel works exactly like the Shot List panel in the Main Window, but enables you to 
open multiple layer panels. You can change which layer is displayed on each panel – 
select Layout > Go To Layer, then select a different layer. 
RMD User Guide | 81707 February, 2012
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Getting Started
Introduction
The best way to get started using Rich Media Desktop is to quickly work through all it’s 
main features. This tour presents a series of three tutorials, each designed to help you 
understand how to create and broadcast presentations using Rich Media Desktop. 

As you work through these tutorials, you will also become familiar with important Rich 
Media Desktop concepts and how you can use them to deliver high quality broadcasts. 
The more you know about Rich Media Desktop, the better it will serve your 
broadcasting objectives.

Because each tutorial builds on the skills and knowledge you learn in the previous 
tutorials, it is recommend that you take the tours in succession. Working through all the 
tutorials takes about thirty minutes.

As you gain hands-on experience creating video and audio presentations - which leads 
to a working knowledge of Rich Media Desktop and its components and architecture - 
you will gain proficiency in using Rich Media Desktop.

Tutorials
 Tutorial 1: Basic Concepts

 Tutorial 2: Editing Shots

 Tutorial 3: Broadcasting

Note: You can run all of the tutorials without a license. However, a watermark on the 
video and an occasional voice-over on the audio are present until a valid license is 
activated. 

Note: For licensing information, select Preferences from the File menu, click the Add 
(+) button, then click Purchase. 

http://www.telestream.net/vantage/help
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Tutorial 1: Basic Concepts
The goal of this tutorial is to provide you with a quick but successful experience 
creating and broadcasting a presentation using Rich Media Desktop. This tutorial 
requires that you open the tutorial document in Rich Media Desktop. To do this, select 
Create Document for Tutorial from the Help menu in Rich Media Desktop. A new 
window will open as shown below:

Figure 9. Main window in Tutorial

The Main Window
Rich Media Desktop has two main display areas: Live Broadcast and Shot List. The Live 
Broadcast is the large area in the upper portion of the window displaying what Rich 

Note: If you are running the tutorial with Rich Media Desktop in demonstration 
mode, the Rich Media Desktop logo will appear from time to time and audio output 
will have a periodic voice-over.

Select Help > Create 
Document for Tutorial
February, 2012 RMD User Guide | 81707
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Media Desktop will broadcast to your viewers (or record to disk). The Shot List, in the 
lower half of the window, displays the shots available for broadcast:

Figure 10. Live Broadcast Area and Shot List 

What Is a Shot?
Rich Media Desktop uses the concept of a shot to construct presentations. A shot 
contains media, along with the settings for that media. In its simplest form, a shot 
contains one piece of media such as a photo or a video clip. But it can also be 
something more complex, like a live camera with a title, and background music.

A shot can be edited and its settings can be changed (See Tutorial 2: Editing Shots). 
Shots are important because they enable you to configure a lot of information before 
you broadcast your presentation. This enables you to concentrate on creating a good 
production during your broadcast. 

Switching Between Shots
Individual shots are displayed in the Shot List. Click the Ripples shot in the Shot List area 
and the image fades into the Broadcast Area display. This is called taking a shot live. 
Click the shot labeled Blank Shot and the Ripples image fades to a blank screen. The 
Blank Shot enables you to display nothing, which is sometimes useful. 

Transitions and Go Button 

Transitions
In the previous examples, a fade occurred when you clicked on a shot. This is because a 
smooth transition is the default. Transition controls are located just below the 

Live Broadcast area

Shot List

Ripples shot
RMD User Guide | 81707 February, 2012
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Broadcast Area where three kinds of transitions are shown: Cut, Smooth, and 
Bowstring.

Figure 11. Transition Control Panel

When Cut is selected, transitions are immediate. When Smooth is selected, transitions 
fade in (as demonstrated above). Select Bowstring to implement the transition with a 
wave effect (like a bow string when it is released).

To see the Bowstring effect, Click the River shot to place it in the Broadcast Area. Next, 
click the Bowstring button. The Transition panel should like this: 

Figure 12. Bowstring Transition Control

Now click the Ripples shot. The Ripples shot will appear using the Bowstring (wave) 
effect. 

There are more than just three kinds of transitions to choose from, but only three can 
be assigned to the Transition Panel. To select a different transition type, click the small 
arrow on the right side of the transition button. When the list appears, select a new 
transition to be assigned to this button. You can also click the transition button and 
drag the mouse downward until a menu of selections is displayed.

For example, change the first button (Cut) to be Swoop by clicking on the Cut button 
and dragging downward until the menu appears. Next, select Swoop from the menu. 
Swoop should now be selected for the first button. Now click back and forth between 
River and Ripples using Swoop.

These three transition buttons can also be selected by using the following key 
combinations: Ctrl+1, Ctrl+2, and Ctrl+3. 

Transition Speed 
You can also Control how fast a transition will occur, by clicking the Clock (Transition 
Speed) icon: 

Figure 13. Transition Speed Icon

Click on the clock icon and choose Slow from the menu. When Slow is selected, the 
clock icon changes to a small turtle, indicating slow mode: 

Figure 14. Slow Transition Icon
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In Slow mode, when you perform a transition it will occur slower than normal. When 
faster transitions are selected, the icon changes to display a rabbit.

Go Button 
The Go Button (or Ctrl+G) enables you to make a transition occur at any time.

Figure 15. The Go Button

Clicking the Go button does nothing when Rich Media Desktop is in its default mode of 
AutoLive. Later in this tutorial you will discover how to use the Go button to transition 
between different shots when the AutoLive mode is off.

Layers 

Rich Media Desktop enables you to use several layers. Layers are different kinds of 
displays (shots, logos, titles, etc.) placed on top of each other so that all are seen at the 
same time. It is an excellent way to add and remove objects in your broadcast. 

To open the Layer Panel, select Layer Panel from the Layout menu at the top of the Main 
window. You can also open the Layer Panel by hovering over the narrow grey panel on 
the left side of the Shot list until a double arrow is displayed, then clicking and dragging 
to the right until the Layer Panel is displayed: 

Figure 16. Two Ways to Open the Layer Panel

Note: Before you start this section, please select Smooth as your transition.

Select Layout > Layer Panel

Click and drag to the right
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Layers are displayed in a particular order: Master Layer 1 is on top, Master Layer 2 below 
it, Master Layer 3 below Layer 2, etc. This tutorial, so far, has been operating on Master 
Layer 3. 

Figure 17. Layer Panel Display

Now select Master Layer 2 by clicking it. Each shot is assigned to a particular layer, so 
when you switch layers you only see the shots that are on that layer. For example, 
Ripples, River, and Blank shots are on Master Layer 3 (as seen previously in this tutorial), 
but Master Layer 2 has only a logo and a blank shot. 

Figure 18. Master Layer 2 Shots

Layer Panel

Master Layer 3
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Click on the shot named Logo. Notice that the Logo fades into the top-right corner of 
the Live Broadcast area: 

Figure 19. Logo Shot Added

Layers can also be made invisible by unchecking the checkbox for that layer. 
Unchecking Master Layer 2 causes the Logo to be removed from the Broadcast area.

Figure 20. An Unchecked Layer

Re-check the Master Layer 2 check box and the Logo will reappear.

Auto Live 

Uncheck to make 
layer invisible

Note: Before you start this section, please make sure that all layers are visible (all 
layer check boxes are checked), and that you are on the Master 3 Layer, which shows 
Ripples and River shots.
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Figure 21. Master 3 Level with All Layers Visible

So far in this Tutorial, Rich Media Desktop has been running in AutoLive mode. What 
this means is that any change you make on the Main window is automatically made live 
in your Broadcast. This mode is very useful for those users who want to set up all of 
their shots at once and then single-click them as they run their presentation. But the 
disadvantage of this single-click method is that you can only see one shot change at a 
time. Once you click a shot, your viewers also see it (with no preview of how it will look 
on your part). 

Turn AutoLive Off 
Turn AutoLive off by unchecking AutoLive in the Switch menu. A dialog box will be 
shown informing you that AutoLive mode is off and transitions must be made using the 
Go button. Click OK in the dialog box to continue.

Try clicking the Ripples and River shots. Nothing happens because AutoLive mode is 
off. Now click the Ripples shot and click the Go Button. The Ripples shot is taken live in 
the Broadcast area. Click the River shot and, as expected, nothing happens. Click the Go 
button and River shot becomes Live. 

Multiple Changes
The benefit of having AutoLive off is that you can make several changes first and then 
have them occur all at the same time. To do this, verify that AutoLive is off and click the 
Ripples shot (you should still see River in the Live window). 

Note: When AutoLive is off, you must always click the Go button (or press the Ctrl+G 
keys) to display the selected shot in the Broadcast area. 
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Now click Master Layer 1 in the Layers Panel and click Sample Title. Click the Go button 
(or Ctrl+G) and notice how both the Ripples shot and the Sample Title shot become 
Live at the same time.

Preview 

One issue you may have noticed while running this tutorial is that you cannot see the 
changes you are making before broadcasting them. To solve this problem, Rich Media 
Desktop enables you to see a Preview of what you will broadcast. 

Select Preview from the Layout menu. The Left side of the Main window is the Preview 
area. Notice that it has a small green square with the letter P inside it. The Right side is 
the Live Broadcast area as before. Your Main window should now look like this: 

Figure 22. Main window with Preview Display

Note: Before proceeding, make sure Master Layer 3 is selected, and the Ripples shot 
is also selected.
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Turn off Master Layer 1 and Master Layer 2 by unchecking both checkboxes. This 
removes the logo and title from the Preview. Now click the Go button to transition the 
Preview into the Broadcast area: 

Figure 23. Unchecked Master Layers 1 & 2
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Tutorial 2: Editing Shots
The first tutorial used only the Main window, and explained various ways in which you 
can use an existing shot. But shots can also be created and edited. This tutorial 
demonstrates how to edit your shots to meet your presentation needs.

Shots can be configured in different ways. Some shots have only titles and some just a 
logo, others have only a photo. Shots are created to be used in broadcast presentations. 
When you broadcast you are choosing, in real time, the shot you want to display. Shot 
editing enables you to make shots you need for your broadcast. 

Figure 24. Tutorial Main window

Shot Editor Overview
Double click the Ripples Shot. This opens the Shot Editor window. 

Note: Before you start this tutorial, create a new tutorial document by selecting 
Create Document Tutorial from the Help menu. You should see a new Main window as 
shown below:

Note: If you save a document with the Shot Editor window open, Rich Media Desktop 
remembers this and will re-open the edit window when the document is re-opened. 
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The Shot Editor window has three main areas: Shot Preview, Configuration Area, and 
Source Layers.

Figure 25. Shot Editor window

Shot Preview This area shows exactly what this shot will look like to your viewers when 
you take this shot live. 

Configuration Area This is where you make changes to the content of the shot, and set 
it's parameters. The configuration area changes appearance depending on the selected 
Source Layer. Click the source icon in the configuration area and it will become invisible 
in the Preview.

Source Layers This area enables you to add, remove, and reorder the sources in your 
shot. Sources are ordered visually from top to bottom. For example, the first source in 
the Source Layer List will appear on top of all other sources in the preview. This list also 
controls visibility of each of the elements in the shot. 

Source Layers 
The bottom left part of the Shot Editor window lists the sources that make up your shot. 

Figure 26. Shot Sources

Shot Preview

Configuration area

Source Layers
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Click on the Logo icon (source) in the Configuration Area. Notice that the Logo is 
displayed in the Shot Preview area. Click the Ripples icon (source) and the Preview 
switches to Ripples. This is how you change the source media for this layer in the shot. 

Template Window
The Template window icon is located in the controls bar in the middle of the window. 

Figure 27. Template window Icon

Click on the template window icon to open the Template window. Select the Angled In 
template and click the Apply button: 

Figure 28. Template window

Notice the Preview has changed again in the Shot Editor window, and now shows the 
Ripples image on the Left side. This is because the template selected has an A and a B 

Select Angled In

Click Apply
RMD User Guide | 81707 February, 2012



Getting Started
Tutorial 2: Editing Shots

42
portion to it. Two different sources can be assigned to A and B, but for now only A is 
assigned (with the Ripples source):

Figure 29. Shot Using Template

Sources in Rich Media Desktop can be assigned either A, B or C in the Source Layers list. 
To change the assignment, click the A (or B or C) icon and make a selection. This makes 
choosing a new template much simpler because Rich Media Desktop automatically 
positions the correct sources on screen.

For example, to change the media for the source that is identified as B, select the source 
identified as B, then click the River icon in the Configuration area. Your Preview should 
now look like this: 

Figure 30. Preview with New Media Source

Click on the B source

Click on the River icon
February, 2012 RMD User Guide | 81707



Getting Started
Tutorial 2: Editing Shots

43
Titles 
You can also add a title to a shot. First click the plus (+) button on the bottom of the 
Source list to add a new layer: 

Figure 31. New Layer Added

To add a title template, click the T button on the control panel: 

Figure 32. Title Template Icon

Select the title template called Blue Banner 3 (items are not listed alphabetically) and 
your preview will add the title: 

Figure 33. Blue Banner 3 Selection

Click the 
plus button

New source 
layer added

Click T button

Blue Banner 3 
displayed

Select Blue 
Banner 3
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Next, click the T icon in the Attributes bar to enable text editing: 

Figure 34. Edit Text window

Type text into lines 1 & 2 and it will display in the preview window: 

Figure 35. Added Text

Click T

Two lines of text
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Effects/Motion 

Positioning Objects 
The sources in a shot can be positioned anywhere on the on screen. Make sure Blue 
Banner 3 is selected. Click the Effects tab in the Shot Editor. 

Figure 36. Effects window Display

Though the title element is initially placed in the bottom middle of the Preview screen, 
it can be moved anywhere. To move the title, click and drag it to a new location. You can 
also move the title to an edge, corner, or center by clicking on one of the repositioning 
buttons in the configuration area:

Figure 37. Repositioning Controls

You can also resize or rotate the title. 

To resize the title (while respecting aspect ratio), hold the Alt key down while moving 
the mouse vertically. To resize (independent of the aspect ratio), hold the Alt key and 
the shift key down while moving the mouse vertically and horizontally. The Respect 
Aspect Ratio checkbox in the configuration area must be unchecked.

To rotate the title, hold down the Ctrl key while moving the mouse vertically and 
horizontally. 

Click the effects tab

Select Blue Banner 3

Click a button to 
move an element
RMD User Guide | 81707 February, 2012



Getting Started
Tutorial 2: Editing Shots

46
Motion for Objects 
All objects (including the title) can have motion assigned to them. Click the Motion tab, 
to open the Build-In/Build-Out configuration panel: 

Figure 38. Motion window

Motion will only occur during a transition (when you click Go, or click a shot in AutoLive 
mode). Motion defines how to add (Build-In) or remove (Build-Out) a shot element. 

There are two forms of Motion: 

1. Build-In (add) Build-In motion occurs when the shot is added to the Live Broadcast 
display. 

2. Build-Out (remove) Build Out motion occurs when the shot is removed from the 
Live Broadcast display. 

Changing Motion Options 
Click the menu under Build-In in the configuration area and select From Left. Also check 
the Decelerate In checkbox: 

Figure 39. Motion Control Selections

To see this behavior in action, you must go back to the Main window and trigger the 
Build-In action,. To do this, follow these steps:

Click the Motion tab

Click and select From Left

Check Decelerate In
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1. Close the Shot Editor window by clicking the X in the upper-right corner of the 
window.

2. In the Main window, make sure Smooth transition is selected. 

3. Click on the Blank Shot, then click the Ripples shot (recently edited). 

Notice that when the Title appears it comes in from the left. 
RMD User Guide | 81707 February, 2012



Getting Started
Tutorial 3: Broadcasting

48
Tutorial 3: Broadcasting
This tutorial demonstrates how to setup and broadcast your Rich Media Desktop 
presentations. You can broadcast to a specific computer (Unicast), multiple viewers 
(Multicast), or even record your broadcast to disk.

There are two main components for broadcasting your presentation (or saving it to 
disk): 

1. Encoding You need to decide how you are going to encode the broadcast. Encoding 
is the type of compression you will use (JPEG, MPEG4, etc.). Rich Media Desktop 
comes configured with many common encoding options. 

2. Destination A destination for the broadcast must be selected. You can send it to a 
server for broadcast or save it to disk.

Broadcast Settings 
To display the Broadcast Settings window, select Broadcast Settings from the Broadcast 
menu (or press the Ctrl+Y keys).

Multiple settings for the same broadcast can be listed in the top part of the Broadcast 
Settings window. For example, you might want to create a broadcast with multiple bit-
rates for viewers using different internet connections. You may also want to record to 
disk while broadcasting your presentation. To add a new broadcast setting to the list, 
click the plus (+) button.

Use the encoder presets menu to select how your broadcast will be encoded (which 
CODEC to use). For the purpose of this tutorial, select any of the encoders, or just use 
the default setting. 

Configuration options depend on the encoder selected. Only three streaming types are 
available:   Windows Media, Flash, and QuickTime.

Use the Destination menu to select the destination of your broadcast. Most of these are 
remote server locations, but the last option enables you to save your broadcast on your 
local disk.

Figure 40. Broadcast Settings window

Broadcast settings list

Click to add a new setting

Select encoder

Select destination
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QuickTime Streaming 
From the encoder presets menu, select one of the H.264 (QuickTime) encoders.

Figure 41. QuickTime Streaming Setup window

Rich Media Desktop provides five destinations for QuickTime streaming: 

1. Announce to QuickTime streaming server This will talk to a QuickTime streaming 
server and uses the server to send the broadcast to users who view that server. (This 
is the default destination.)

2. Built-in streaming server Rich Media Desktop includes a built-in streaming server 
which will allow a small number of viewers to view your broadcast. Define the name 
of the SDP file and you can immediately broadcast. 

3. Unicast This will broadcast directly to one single client (computer). You must define 
the address for the single client, then the presentation is streamed directly to that 
computer. 

4. Multicast This is an advanced feature that will broadcast globally on a network. In a 
LAN environment, this option can provide the ability to broadcast to multiple users 
without using QuickTime streaming server. This feature only works over a LAN, not 
over the Internet. 

5. Record to Disk If you want to save your broadcast, you can use this option to record 
the broadcast stream to disk. 

Announce to QuickTime streaming server
Since this is the most common method for QuickTime, you should always consider 
using this option for your broadcast. To use this feature, you must supply a host name 
and file location. You need to supply a user-name and password only if your server 
requires a login. 

Note: Clicking in the list area on a location that de-selects all the settings creates a no 
output state. This is corrected by clicking any setting on the list.

Select encoder
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This feature requires that you have access to a QuickTime streaming server (QTSS) or 
Darwin streaming server (DSS). Darwin streaming server is a free download from Apple 
and can be installed on many operating systems (not just Macintosh). 

Unicast
Unicast is used to broadcast to only one computer. To set up a unicast, follow these 
steps: 

1. Obtain the IP address of the target computer, and configure your broadcast using it. 

2. Save an SDP file on the target computer. 

3. Start broadcasting your presentation. 

4. The viewer must open the SDP file using QuickTime Player to see your presentation. 

Multicast
Multicast is used to broadcast to any computer on your local network (not the internet). 
To use this feature, you must create and distribute an SDP file to all users on your local 
network who want to view the stream. 

The Video Address and Audio Address (and related ports) are, effectively, fake 
addresses that do not really exist on the local network. This information is stored in the 
SDP file so that client applications know where to look for the stream. The default 
addresses/ports that Rich Media Desktop generates are generally sufficient to use. 

To set up a multicast, follow the same step given for Unicasting. (See Unicast, 
immediately preceding.) 

Record To Disk
If you want to archive your stream, you can use the Record To Disk destination. The only 
setup information required is the filename. If you use Auto Increment Filenames, all files 
will be saved with a sequential number appended to them. 

Windows Media Streaming
Select any WMV from the encoder presets menu.

Note: If you change any setting regarding the broadcast (encoding settings, etc), you 
must re-create and re-distribute the SDP file. 

Note: Windows Media options are only available when running on a Windows 
computer. 
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Figure 42. Windows Media Streaming Display

There are three destinations available for Windows Media: 

1. Network The stream will be broadcast over the network, using either a server or 
your local computer. 

2. VBrick The stream will be sent to VBrick for broadcast.

3. Record to Disk If you want to save your broadcast you can use this option to record 
the stream to disk.

Network-Push To Server
To use the Network-Push To Server option, you must have access to a local Windows 
Media Server, or one located at an ISP (search the internet for Streaming Windows 
Media Server to find one). Using this option is a more professional way of creating a 
stream because it places the bandwidth strain on the remote server. All you need is a 
good local connection to the internet to push your presentation onto the Windows 
Media Server. 

To configure this setting, enter the Internet address of the remote server, the file name 
that will become part of the URL that your users use to start the presentation, and any 
user name/password required by the ISP. If you check Auto Remove the file is deleted 
from the server when your presentation is finished.

Network-Pull from Server
The Network-Pull from Server option turns your local computer into a mini Windows 
Media Server. This enables you to broadcast immediately from your computer, rather 
than through an ISP. There are, however, some limitations: 

1. User Requirement You cannot have more than 50 users connected at any one time.

2. Bandwidth Requirement You must have enough bandwidth on your computer to 
supply all of your viewers.

3. CPU Requirement Since your computer is acting as a server, the CPU must be fast 
enough to handle all of the user connections.
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The largest issue is with using this method is bandwidth. If, for example, all of your 
viewers are on a local network (a business or school), then you should be able to use 
this method. However, if you have a DSL connection to the internet and you want to 
broadcast a 200k stream to 20 viewers, you will probably not have enough upload 
bandwidth to accommodate this. 

To use the Network-Pull from Server option, set the port number that your users will 
use to connect to your computer. They will connect by using the Open URL option in 
Windows Media Player and enter a URL. For example, mms://192.168.1.67:8080 
represents a computer IP address of 192.168.1.67 and a port number of 8080. 

Flash Streaming
Select Flash Medium Bandwidth from the encoder presets menu. Rich Media Desktop 
can stream to several Flash streaming servers, including Flash Media Server (Adobe) 
and Wowza streaming server (Wowza).

When you configure Rich Media Desktop to stream using Flash, Rich Media Desktop 
displays a Flash queue bar in the main window. The Flash queue shows you how much 
data is currently buffered on your computer, waiting to be transferred to the server.

Figure 43. Flash Streaming Setup window

Encoder presets
encoder presets enables you to select an encoder used for broadcast. If you change the 
preset to another encoder type, the list of destinations associated with it will also 
change. The destinations are tied to the type of codec you are using. 

Note: Be aware that when you use Rich Media Desktop with an internet connection, 
the limiting factor is your upload bandwidth. Most ISP businesses offer packages that 
have a higher download than upload bandwidth. For example, a 512k DSL package is 
often limited to 256k of upload bandwidth. 

Note: The URL "mms://" does not work with the Macintosh version of Windows 
Media Player, and you must use "http://" instead.

Select Flash Medium 
Bandwidth
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Destination
The Destination menu lists many CDN’s and live streaming Websites. You need to have 
an account with the selected destination to use that service. You can also select Record 
to Disk as a destination for your presentation. The RTMP Flash Server is the default 
destination.

Address
The address of the selected destination is obtained from your Flash Media Server 
administrator for this URL.

Stream
Each Flash stream requires that you enter the name of the stream. Contact your Flash 
Media Server administrator to obtain this name.

Open FMLE XML File 
Rich Media Desktop can load configuration files that have been created for Flash Media 
Live Encoder (FMLE). Rich Media Desktop will read the RTMP Address and Stream Name 
from this file, but it will not read any other configuration information from the FMLE 
XML file (bit rates, codec configuration, etc.). Many popular sites provide an FMLE 
configuration file for your stream configuration.

User Agent
Although rare, some streaming services require that Rich Media Desktop presents itself 
as FMLE when broadcasting. By default, Rich Media Desktop correctly presents itself as 
Rich Media Desktop/FM 1.0. Do not change this unless your provider has asked you to 
do so.

Set Credentials
Some Flash Media Servers require authentication. Rich Media Desktop offers the 
standard Adobe authentication method. However, if required to do so by your server, 
you must enter your credentials here. But if your server does not require authentication, 
there is no need to provide these credentials.
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Adding Media
Introduction
In addition to live video from your cameras, Rich Media Desktop enables you to work 
with media created outside of Rich Media Desktop. This section introduces some 
common media types you can use with Rich Media Desktop.

There are three ways to add media to Rich Media Desktop: 

1. Drag & drop into a new shot. The simplest way to add media to a shot is to drag & 
drop the media directly into Shot List in the Main window.

2. Drag & drop into an existing shot. To add media to an existing shot, drag & drop 
the media directly into the Shot Editor's media list.

3. Select directly. You can add a media by selecting Import Media fro the File menu, by 
pressing the Ctrl+Shift+I keys, or by clicking the plus (+) button in the Shot Editor.

Topics
 Images/Opacity

 Movies



Adding Media
Images/Opacity

56
Images/Opacity
Rich Media Desktop supports a wide variety of still images types (TIFF, GIF, JPEG, PNG, 
etc). Some of these formats offer some form of opacity (or transparency). This is often 
called an Alpha Channel. Rich Media Desktop works seamlessly with these formats 
making them the preferred methods for using graphics and logos, which have 
transparency.

GIF and Transparency
GIF files are a special case because they only offer transparency and not a true Alpha 
Channel. The GIF format enables you to define part of the image as transparent 
(completely invisible), but does not enable you to define it as partially transparent. 
Some GIF images use transparency for much of the image. However, near the edges of 
the visible data, transparency cannot be used. This happens quite often when there is a 
shadow near the edges of the visible data. The author of the GIF often assumes a 
certain background color (white, for example) and that color becomes embedded in 
the actual image.

When Rich Media Desktop displays these types of images, the edges of the visible data 
will show the background that was saved in the GIF. This is not a defect in Rich Media 
Desktop and, therefore, Rich Media Desktop can only present the data as it exists in the 
GIF. The solution is to obtain the original image and re-save the image as either TIFF or 
PNG. Both of these formats offer full Opacity.
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Movies
Rich Media Desktop supports a wide variety of movie formats (MOV, AVI, WMV, etc). 
Sometimes, however, you need to install a codec to use these formats. A very 
commonly desired codec is DivX®. Rich Media Desktop will inform you if a codec is 
missing or if you need to install one. It is beyond the scope of this user guide to 
describe all of the possible codecs available on the market today, or explain the 
installation details. Contact the provider of the codec for details on installation.

Problems Showing Movie Types
Although there is always the possibility that Rich Media Desktop is at fault, please try to 
open the media with QuickTime player and/or Windows Media Player before 
contacting technical support. If these players cannot open the file, most likely the 
codec is not properly installed (or there is no available codec for that media).

Please note that Rich Media Desktop does not currently support some file formats 
(.mpg, .mpeg, .m1v, .m2v). The solution is to convert the media into a different type 
such as MPEG-4.

If QuickTime Player can play the media and Rich Media Desktop cannot, contact:  your 
VBrick representative.

AVI Video
Some AVI files may play the audio but not the video. The solution is to convert the 
media into a different type, such as MPEG-4.

Real Media
Real Media Files (.RM) are not supported by Rich Media Desktop. The solution is to 
convert the media into a different type such as MPEG-4.
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Using Titles
 Introduction
Rich Media Desktop offers a wide variety of title banner templates to use in your 
broadcast. Adding a professional looking title is as simple as selecting a template and 
adding your text.

Topics
 Adding Titles

 Modifying Titles

 Title Area

 Placing Titles

 Creating New Templates
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Adding Titles
To add a title to a shot, double-click the shot to open it the Shot Editor: 

Figure 44. Shot Selected for Editing

Rich Media Desktop displays the shot you selected in the shot editor window: 

Figure 45. Shot Display in Shot Editor window

Double-click a shot to edit
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Adding New Source
To add a new source, click the plus (+) icon in the Sources Toolbar at the bottom-left 
corner of the Shot Editor window. Rich Media Desktop adds a new source entry, labeled 
“[no media]”.

Figure 46. New Source Display

Using the tools in the Attributes toolbar and the Media Panel, you can configure your 
source so it displays as requires:

Figure 47. Attributes Toolbar

Configuring Titles
The basic configuration for a media source is a title bar with text captions. Other 
attributes are optional. As you configure the media, you can view your progress in the 
Preview area at the top of the Shot Editor window. To configure a title, follow these 
steps:

1. Select the Change Media icon in the Attributes toolbar. (Each time you create a new 
source, the media icon is selected for you). 

Newly added source

Source Toolbar

Click plus to add new source

Attributes toolbar

Crop icon

Media Panel, T icon

Change Media icon

Text icon

Visual Effects icon

Config Media Settings

Motion icon

Chroma icon
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2. Click the T icon in the Media Panel to display titling templates. Scroll through the 
icons and select the banner graphic you want to use for a title. Be sure to select a title 
banner that is graphically designed to display the number of lines (1 to 4) you intend 
to use for this source. Rich Media Desktop provides many templates, but you can also 
create your own. 

3. Click on the Visual Effects icon in the Attributes toolbar to adjust the position of the 
banner, control its opacity and matting, and set other visual effects. Usually, no 
adjustments need to be made.

4. Click on the Crop icon in the Attributes toolbar to crop the banner graphic as 
needed. As you adjust crop values, you can see the effect in the Preview window. 

5. Click the Text icon in the Attributes toolbar and enter up to 4 lines of text to display 
in the title. You can adjust paragraph formatting, font characteristics, and font color 
using the buttons to the right of each line. 

6. If you plan to chroma key the title, click the Chroma icon in the Attributes toolbar to 
enable and set up the chroma key. See Shot Editor Chroma Key to learn how to 
enable and configure chroma key settings.

7. Click on the Motion icon in the Attributes toolbar to set up your builds.

8.

Note: For more detailed information on the above steps, see Edit Menu.
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Modifying Titles 
To modify the titles, you have to edit the shot. Double-click the shot to open the Shot 
Editor. Click the title attributes tool (T) in the Attributes toolbar. The title modification 
screen will be displayed: 

Figure 48. Title Modification Screen
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Title Area
Depending on the title source selected, you can modify up to four lines of information. 
Each line of text has its own justification, font, and font color settings.

Figure 49. Line 1 of Title Modification Area

Changing Text
To change the text, enter the text into the text entry area for the line to be changed. 
Rich Media Desktop supports all text entry (even in-line entry engines for Japanese, 
Korean, Chinese, etc).

Changing Justification
Justification is controlled by clicking on the justification icon and selecting left, center, 
or right from the drop-down menu. 

Figure 50. Justification Icon

Changing Font
Click the font selection icon to open a font selection window. Click the icon again to 
close the font selection window.

Figure 51. Font Selection Icon

The font selection window is a floating palette that changes the text as you make 
selections. So if you click in a different text entry area, the font panel will notice this and 
configure itself to the settings of the new text entry area.

Font Color

Font 

Justification

Note: The only items that Rich Media Desktop recognizes in the Font Panel are: Font 
Family, Typeface, and Size. All other settings are ignored by Rich Media Desktop 
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Changing Font Color
Click the font color icon to change the color of the font. A standard font color selection 
window is displayed. Choose the color you desire and click OK.

Figure 52. Change Color Icon
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Placing Titles
The previous sections describe how to create and edit a title for an existing shot. 
However, you can also create a shot which has only title data. This is very useful if you 
want to place the same title over several different shots or if you want to modify the 
title independent of the shot you are choosing. But you must decide, based on your 
type of broadcast, if you want your titles to be tied directly to specific shots or if you 
want them to be independent. Rich Media Desktop seamlessly supports both methods 
-- even both methods at the same time.

Seminar Title
You may want to broadcast a seminar and have the title of the seminar appear and 
disappear while switching between several other shots or cameras. In this case, create a 
shot which has only the title in it, enabling you to move this title to a Foreground layer. 
In this configuration, you can bring the title in and out of your broadcast by selecting it 
in the Title Layer. By placing the title in this separate layer, it keeps it independent of the 
all other shots you have created.

Interview Title
If you are broadcasting an interview, the shot which contains the camera for the 
interviewee may have a title in it. In this case, when you cut to the shot of the 
interviewee, the title will appear. When you cut to the person asking the questions, the 
title will not appear because it is a different Rich Media Desktop shot.

Note: Since you can turn visibility of a title on and off inside the shot editor, you can 
still turn the title on and off on the shot. To do this, make the shot live, then open the 
shot editor. Check the Title checkbox, click Go (or press Ctrl+G). Then uncheck the 
Title checkbox and click Go again.
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Creating New Templates 
The templates that Rich Media Desktop uses are not editable within Rich Media 
Desktop. However, you can create new templates yourself using other development 
application programs. Rich Media Desktop looks in the My Documents directory for a 
sub-directory called RMDTitles. You should place your own titles there.

Other Media
Any media used by these templates must exist in the same template folder. For 
example, if user_scoreboard.png is used in one of the example templates, it must be 
located in the RMD_User_Titles directory.

Editing XML Files
There is an XML file called description.xml which describes all of your titles. Edit it to 
add, create, or delete titles. Read the header of the XML file for a list of rules and 
descriptions. Backup the file before editing because syntax errors will cause Rich Media 
Desktop not to parse the file.
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Using Logos
Introduction
When you perform a broadcast, you may want to include a company logo in your 
presentation. There are two ways you can do this in Rich Media Desktop: 

1. Global Logo (logo is its own shot) In this configuration, you create a shot which has 
only a logo in it. The benefit of this configuration is that you can show the logo 
independently of all other shots. For example, you can choose to always show the 
logo in a corner of your broadcast display. 

2. Shot Logo (logo is part of another shot) In this configuration, you add a logo to an 
existing shot. This is useful if you want to have a shot you will use in the start of your 
broadcast. 

Topics
 Global Logos

 Shot Logos
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Global Logos
Logos are only displayed through shots. Rich Media Desktop treats logos the same as 
any other static media. To create a new empty shot and add your logo to it, follow these 
steps:

1. In the Main window, select Layout > Layer Panel. 

2. Double-click Master Layer 2.

Figure 53. Master Layer 2 Display

3. Add a new shot by selecting Edit > Add Shot:

Figure 54. New Shot Added

4. Edit the new shot by double-clicking the shot named New Shot. When the Template 
window displays, select Fullscreen View and click Apply.

Note: Layers can be re-named at any time. 

New Shot
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5. To add your logo, click the Add Shot button:

Figure 55. Shot Editor window

6. Select logo.png. The logo is displayed in the Preview window: 

Figure 56. Logo Display
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7. Position the Logo. Most likely, you will not want to display the logo in the middle of 
the shot. To re-position it, click the Position button in the Attributes Toolbar. 

Figure 57. Positioning Controls

8. The logo can be moved, resized, and rotated using these controls:

 Move:  Click and drag object to a new location.

 Resize (maintaining aspect ratio):  Hold the Alt key down while moving the mouse 
vertically.

 Resize (independent of the aspect ratio):  Hold the Alt key and the Shift key down 
while moving the mouse vertically and horizontally. The Respect Aspect Ratio check-
box in the configuration area must be unchecked.

 Rotate:  Hold down the control key while moving the mouse vertically and horizon-
tally.

9. You can also move the logo to an edge, corner, or center by selecting the logo and 
clicking on one of the repositioning buttons in the configuration area:

Figure 58. Repositioning Controls

Click a button to 
move an element
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10.To add your Logo to the broadcast, close the Shot Edit window, and click the logo 
shot in Master Layer 2: 

Figure 59. Shot Display in the Foreground Layer

11.Change the shot level to Master Layer 3 in the Master Layers list. Notice that 
changing shots does not affect the logo you have put on the Master Layer 2.

Figure 60. Changed Layer Display

Select shot
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Turning Layers On and Off
One way that you can use Rich Media Desktop is to turn layers on and off. For example, 
Master Layer 2 can be turned off and then back on by checking and unchecking its 
checkbox. This is a very effective way to have a logo ready to display.

Figure 61. Turning Layer Off

Uncheck Layer
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Shot Logos 
To create a Shot Logo, add your logo to an existing shot. To do this, follow these steps:

1. Double click a shot to open it in the shot editor.

Figure 62. Opening a Shot to Edit

2. Click the Add Source button to add a new source: 

Figure 63. Top Source Display

Double-click a shot

Click the Add Source 
button
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3. To add your logo click the plus (+) button then click the logo icon:

Figure 64. Top Source Display

4. Most likely, you won’t want to display the logo in the middle of the display. To re-
position it, click the Position button to display the positioning controls:

Figure 65. Positioning controls

You can also reposition the logo using the mouse:

 To Move Media:  Click and drag using the mouse in the Preview area.

 Resize (Respect Aspect):  Hold the Alt key while moving the mouse in the Preview 
area.

 Resize Media:  Turn off Respect Aspect Ratio. Hold the Shift-Alt keys while moving 
the mouse in the Preview area.

Click Logo

Click the Add button

Click the Configure 
Visual Effects icon

Repositioning 
controls
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 Rotate Media:  Hold the control key while moving the mouse in the Preview area. 
Select between shots in the Main window.

5. Close the edit window and click the River logo to take your changes live. 
     Notice that the River shot now has the logo embedded in it: 

Figure 66. Embedded logo display
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Broadcasting
Introduction
Before you can broadcast with Rich Media Desktop, you must configure your broadcast 
settings. Once configured, broadcasting is as simple as selecting Broadcast > Start 
Broadcast. If you broadcast without configuring, Rich Media Desktop will open the 
Broadcast Settings window for you. 

Topics
 Configuring Broadcast Settings
 Configuration
 Encoder Presets
 WM-Push To Server
 WM-Pull From Server
 QuickTime streaming server
 QuickTime Built-in Server
 QuickTime Unicast
 QuickTime Multicast
 Record To disk
 Flash Media Server
 Flash To VBrick
 Flash Record To Disk
 Annotation Settings
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Configuring Broadcast Settings
To configure broadcast settings select menu Broadcast > Broadcast Settings (or press 
the Ctrl+Y keys): 

Figure 67. Broadcast Settings window

Multiple Broadcast Settings
Rich Media Desktop enables you to specify many broadcast settings for your 
presentation. This means you may configure Rich Media Desktop to broadcast at two 
different bit-rates (modem and DSL, for example), or you may record to disk using 
different encoders. You can even broadcast QuickTime, Windows Media 9, and 
Windows Media 8, all at the same time if you have enough processing power to 
perform real-time encoding.

At the top of the Broadcast Settings window is a list of the current settings. Uncheck the 
checkbox of any setting you want removed from your broadcast. You can add as many 
broadcast settings as you need, but keep in mind that high quality video will require 
greater CPU usage. 

Click the Gear icon to access actions that enable you create reference movies you can 
distribute to your viewers. Each destination type provides a unique set of actions.

List of broadcast settings

Gear (actions) icon
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Configuration
There are two items to configure before broadcasting: encoder presets and 
destinations.

Encoder Preset
The encoder presets defines how your presentation is encoded (or compressed). There 
are many options available. Rich Media Desktop simplifies this process by providing 
several simple presets to choose from. (See Encoder Presets).

Broadcast Destinations
When you broadcast with Rich Media Desktop, you must broadcast to a specific 
destination. A destination can be a server or Record to Disk.

Each encoding preset uses a different broadcast technology (QuickTime, Windows 
Media, etc). The destinations described below depend on the encoder presets you have 
chosen.

Windows Media Destinations
There are two destinations offered with Windows Media: 

1. Network The stream will be broadcast over the network, either using a Windows 
Media server or using your local machine as the server. To use a Windows Media 
server, you need to use the WM-Push To Server option. To use a your machine as a 
server, you need to use the WM-Pull From Server option.

2. VBrick The stream will be sent to VBrick for broadcast.

3. Record to Disk You may also record your presentation to disk. You can do this 
whether or not you are broadcasting to a server. 

QuickTime Destinations
There are four destinations offered with QuickTime:

1. QuickTime/Darwin streaming server:  The QuickTime streaming server (or Darwin 
streaming server) resides on a second computer and acts as what is called a reflector. 
From within Rich Media Desktop, you send your broadcast to this one server and it, 
in turn, sends the broadcast to the many viewers that you have. You must use the 
QuickTime/Darwin streaming server if you want to broadcast a QuickTime stream 
live to multiple viewers.

2. One Specific Computer:  You can configure Rich Media Desktop to send a broadcast 
to a single second computer. This is called Unicasting.

Note: If you want to archive your stream while broadcasting, add a second broadcast 
setting of Record To Disk.
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3. All computers on your local network:  You can configure Rich Media Desktop to 
broadcast so that any computer on your local network can receive the broadcast. 
This is called Multicasting. You cannot Multicast to the Internet, only to the local 
network on which your computer resides.

4. Record to Disk:  You can record your broadcast to disk. You can do this whether or 
not you are broadcasting to another computer.

Flash Log Files
Rich Media Desktop generates log files when streaming to a flash-based destination. 
The files are generated in a rotating fashion with file names of flash_log.txt, 
flash_log_1.txt, flash_log_2.txt, etc. Technical support may ask for these log files when 
attempting to diagnose a flash connection issue. 

Log file locations: 

• Windows 7 and Vista C:\users\$USER$\AppData\Roaming\Rich Media Desk-
top\flash_log.txt 

• Windows XP C:\Documents and Settings\$USER$\Application Data\Rich Media 
Desktop\flash_log.txt 
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Encoder Presets
The encoder presets menu is located in the middle of the Broadcast Settings window: 

Figure 68. Encoder presets Menu

Rich Media Desktop offers several default presets. (See Configuring Broadcast Settings 
for details on selecting a good encoder.)

The first choice you need to make is whether you'll be using Windows Media, 
QuickTime, or both as the broadcast technology. This decision depends on what you 
expect your viewers to use. Given enough bandwidth, you can stream to both 
QuickTime and Windows Media by adding new destinations to the broadcast settings.

Windows Media Settings
With Windows Media, the first choice you need to make is between Windows Media 8 
or Windows Media 9. You can broadcast in both If your CPU can encode both in real 
time simultaneously.

QuickTime Settings
In its simplest form, you need to choose the minimum connection speed for you and 
your viewers. If you or any of your viewers have a modem, you should choose one of 
the modem settings. If all have at least DSL or cable, then you can choose a higher 
speed.

The term motion is used to indicate how much movement there is in a broadcast. If 
you're doing an interview, most likely there will be little motion. If you are broadcasting 
a sports event, high motion is more likely.

In the Encoder Preset, MPEG4 and Windows Media 9 provide four bit-rate categories:

• HD Bit rates of 1800K or 2000k.

• High Bit rates of 1200K or 1500k.

• Med Bit rates of 750K or 1000k.

• Low Bit rate of 256k.

encoder presets menu
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If you are going to only Record To Disk and have your viewers download the file from 
your server, then you may choose to encode for LAN, because your viewers are not 
trying to play the file in real time.
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WM-Push To Server 
To access the WM-Push To Server window, select menu Broadcast > Broadcast Settings 
(or press the Ctrl+Y keys). From the encoder presets drop-down menu, select any of the 
Windows Media based presets, and check the Push to Server checkbox.

To use Push To Server, you must have access to a Windows Media Server, either in your 
organization or hosted by an ISP (search the Internet for Streaming Windows Media 
Server to find one). This is the professional way of creating a stream because it places 
the bandwidth strain on the remote server. All you need is a good local connection to 
the internet to push to the Windows Media Server.

Figure 69. WM-Push To Server Configuration window

Configuration Settings
Address Enter the Internet address of the Windows Media Server you will use to 
broadcast.

Publish Point Enter the name of the file that will be put on the server, and that will be 
used as part of the URL that your users will use. Rich Media Desktop cannot know the 
resulting URL that your users will use, as this may vary depending on the installation of 
the Windows Media Server. Contact your Windows Media Server administrator to 
understand how to build a proper URL for your viewers, based on the Publish Point.

Auto Remove Check Auto Remove to remove the file used as the publish point when 
the broadcast is over.

Username/Password Enter the user name and password for the Windows Media 
Server. Contact your Windows Media Server administrator to obtain these. If there is no 
user name or password required, leave these fields empty.

Select a Windows Media 
based preset

Check Push to Server
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WM-Pull From Server 
To access the WM-Pull From Server window, select menu Broadcast > Broadcast 
Settings (or press the Ctrl+Y keys). From the encoder presets drop-down menu, select 
any of the Windows Media based presets, and check the Pull From Server checkbox.

This option turns your local computer into a mini Windows Media Server, enabling you 
to broadcast immediately. There are, however, some limitations: 

1. User Requirement You cannot have more than 50 users connected at any one time.

2. Bandwidth Requirement You must have enough bandwidth on your Rich Media 
Desktop computer to supply all of your viewers.

3. CPU Requirement Since the Rich Media Desktop computer is acting as a server the 
CPU must be fast enough to handle all of the user connections.

The largest issue is with using this method is bandwidth. If, for example, all of your 
viewers are on a local network (a business or school), then you should be able to use 
this method. However, if you have a DSL connection to the internet and you want to 
broadcast a 200k stream to 20 viewers, you will simply not have enough upload 
bandwidth to accommodate this. 

Configuration Settings
To use the Network-Pull from Server option, set the port number that your users will 
use to connect to your computer. They will connect by using the Open URL option in 
Windows Media Player, and enter a URL (for example: mms://192.168.1.67:8080, 
assuming your computer IP address is 192.168.1.67 and your port is 8080). 

Figure 70. Configuration window

Note: Be aware that when you use Rich Media Desktop with an internet connection 
what matters is your upload bandwidth. Most ISP businesses offer packages that have 
a higher download than upload bandwidth (e.g., a 512k DSL package is often only 
256k upload).
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Port Number Enter the port on your computer to use as the broadcast port. This can 
be, effectively, any port number as long as it doesn't conflict with any existing ports on 
your computer. Be aware that if you have any firewall software installed, you will need 
to enable the port entered here.

Maximum Connections The maximum number of connections your server will accept 
is 50 users. Your CPU will be affected by the number of users you have connected, 
therefore you may need to limit the number of connections.
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Stream To VBrick
To stream to VBrick, follow these steps:

1. Select a WMV Encoder Preset. 

2. Select VBrick from the Destination menu.

3. Enter your VBrick username and click Authenticate. Rich Media Desktop 
authenticates your username, and enables you to stream to VBrick. If you do not 
have a username, click Sign Up (or go to www.vbrick.com) to sign up and obtain a 
username.

4. Click Save to save your settings. 

Figure 71. Stream to VBrick

Select a WMV encoder

Select VBrick

Click Authenticate and 
enter password

Save settings

Enter user name
February, 2012 RMD User Guide | 81707



Broadcasting
QuickTime streaming server

89
QuickTime streaming server
Apple's QuickTime streaming server runs on Macintosh hardware. The Darwin 
streaming server is the open source streaming server offered by Apple, and runs on 
many flavors of Unix (OpenBSD, Linux, etc).

Streaming servers act as reflectors, so your goal is to broadcast from Rich Media 
Desktop directly to one of these servers that, in turn, sends the stream on to your 
viewers. 

To stream to a QuickTime/Darwin streaming server, select Announce to QuickTime 
streaming server as the destination: 

Figure 72. Announce to QuickTime streaming server

Host Name Enter the name (or IP address) of the host computer that is running your 
streaming server.

File Location The streaming server uses a file on the server to contain the specific 
settings for the stream. You need to define the name of that file here. When you send 
your viewers the URL for them to use, this file name will be a part of that URL. For 
example, if the File Location is my_stream and the Host Name is www.stream.com then 
your viewers will use this URL: rtsp://www.stream.com/my_stream.sdp. This 
information displays in the bottom of the window as you configure the settings.

Username/Password Enter the user name and password, if your streaming server 
requires it.

Note: This document does not describe configuring or maintaining QuickTime/
Darwin streaming server.

Note: This password is saved as plain-text in the Rich Media Desktop document.

Select Announce to 
Quicktime streaming 
server.
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Broadcast Over TCP
Defines whether you are using UDP or TCP to send the data to the streaming server. 
This only defines the connection between Rich Media Desktop and the streaming 
server and has nothing to do with how your viewers will receive the broadcast.

UDP is faster, but if you are using a firewall or are behind a NAT, you may not be able to 
use UDP and you should use TCP. So, if Rich Media Desktop can send UDP to the server 
without errors, use it. It is faster.

Actions
When you have Announce to QuickTime streaming server selected, the gear icon will 
have these three actions: 

1. Open in QuickTime Player This opens the stream in QuickTime Player. This is a 
handy shortcut and saves you from typing “rtsp://…” into QuickTime Player.

2. Save Movie This saves a QuickTime movie to disk that contains a reference to the 
configured stream. This Movie file is very small and tells QuickTime where to find 
your actual stream. It does not contain the data of your movie. When you are not 
streaming, this movie will not work for your users. But, you can send this movie to 
your users or post it on your Website so that your users can view your stream when 
you are broadcasting.

3. Save Multi-stream Reference Movie This saves a QuickTime movie to disk that 
contains a reference to all of your QuickTime streaming server streams. You can send 
this movie to your users, or post it on your Website, so that your users can view all 
your streams. QuickTime will then choose which stream to use based upon the users 
settings. This is a handy way to broadcast multiple bit-rates at the same time.
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QuickTime Built-in Server
Rich Media Desktop provides the free Darwin streaming server from Apple. When you 
use the Built-in streaming server it is running on your local computer and will use local 
resources, causing Rich Media Desktop to run slower.

The Built-in Server enables each of your users to connect directly to your computer. If 
you do not have sufficient bandwidth you won’t be able to host many viewers (one or 
two over DSL, perhaps up to five or ten on a local network). If you plan to have many 
viewers, you need use a hosted QuickTime streaming server which is selected from 
Destination > Announce To Quicktime streaming server in Broadcast Settings:

Figure 73. Built-in streaming server

File Location Enter the name of the file used by the streaming server that contains the 
settings for the stream. When you send your viewers a URL to use, this file name will be 
a part of that URL. for example, if the File Location is my_stream and the Host Name is 
www.stream.com then your viewers will use rtsp://www.stream.com/my_stream.sdp. 
This information is display after the File Location as you configure the settings.

Actions
When you have Built-in streaming server selected, the gear icon will provide three 
actions: 

1. Open in QuickTime Player This opens the stream in QuickTime Player. This is a 
handy shortcut and saves you from typing “rtsp://…” into QuickTime Player.

2. Save Movie This saves a QuickTime movie to disk that contains a reference to the 
configured stream. This Movie file is very small and tells QuickTime where to find 
your actual stream. It does not contain the data of your movie. When you are not 
streaming, this movie will not work for your users. But, you can send this movie to 
your users or post it on your Website so that your users can view your stream when 
you are broadcasting.

3. Save Multi-stream Reference Movie This saves a QuickTime movie to disk that 
contains a reference to all of your QuickTime streaming server streams. You can send 
this movie to your users, or post it on your Website, so that your users can view all 

Select Built-in 
streaming server.
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your streams. QuickTime will then choose which stream to use based upon the users 
settings. This is a handy way to broadcast multiple bit-rates at the same time.
February, 2012 RMD User Guide | 81707



Broadcasting
QuickTime Unicast

93
QuickTime Unicast
Rich Media Desktop lets you broadcast to a specific computer. This is called unicast. To 
configure the broadcast settings for a unicast, follow these steps: 

1. Select Unicast under the Destination menu.

2. Enter the address. This is the domain name or IP address of the computer receiving 
your unicast.

3. Enter the Video Port number. This is the video port on the computer receiving your 
unicast.

4. Enter the Audio Port. This is the audio port on the computer receiving your unicast.

5. Create an SDP File. You must create an SDP file every time you change any option on 
this page (including the encoder preset). To create an SDP file click the gear icon and 
select Save SDP File, navigate to the desired location, and click Save in the Save File 
dialog window. The SDP file must be given to the user to be placed on the computer 
that will receive your broadcast. Your remote viewer must open the SDP file using 
QuickTime player.

6. Save a Multi-stream Reference Movie (optionally present). This menu option is only 
available if you have other settings which use Announce To QuickTime streaming 
server.

7. Click the Save button to save your settings.

Figure 74. Unicast Settings

8. Start your broadcast by selecting menu Broadcast > Start Broadcast in the Main 
window.

Note: Your unicast information is not stored in this file. Only QuickTime streaming 
server streams are saved to this file.

Select Unicast

Save settings

Save SDP file

Enter Audio Port

Enter Video Port

Enter Address
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QuickTime Multicast
Rich Media Desktop lets you broadcast to your local network so that any computer on 
that network can view the broadcast. This is called multicast. To configure the 
broadcast settings for a multicast, follow these steps: 

1. Select Multicast under the Destination menu.

2. Enter the Video and Audio Addresses. This is the unique addresses the multicast 
broadcast will use for video and audio. Although this looks like an internet address, it 
is not. This address must be unique among applications on your network that use 
the multicast protocol. Click the Generate button to generate random video and 
audio addresses.

3. Enter the Video Port number. This is the port that the multicast protocol uses for 
video. Normally, this is 5434.

4. Enter the Audio Port. This is the port that the multicast protocol uses for audio. 
Normally, this is 5432.

5. Create an SDP File. You must create an SDP file every time you change any option on 
this page (including the encoder preset). To create an SDP file click the gear icon and 
select Save SDP File, navigate to the desired location, and click Save in the Save File 
dialog window. The SDP file must be given to the user to be placed on the computer 
that will receive your broadcast. Your remote viewer must open the SDP file using 
QuickTime player.

6. Save a Multi-stream Reference Movie (optionally present). This menu option is only 
available if you have other settings which use Announce To QuickTime streaming 
server.

7. Click the Save button to save your settings.

Figure 75. Multicast Selection

Note: Your multiicast information is not stored in this file. Only QuickTime streaming 
server streams are saved to this file.

Select Multicast

Save settings

Save SDP file

Enter Audio Port

Enter Video Port

Enter Video and Audio
Addresses

Generate Addresses
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8. Start your broadcast by selecting menu Broadcast > Start Broadcast in the Main 
window.

How Multicast Works
During multicast, your broadcasting computer sends data across your local network, 
identifying it as a broadcast that it has no specific destination. Since many applications 
could be doing the same thing, the broadcasting computer must have a unique way of 
defining the data that is being multicast. This enables clients to choose between the 
available multicast streams.

The multicast protocol uses unique addresses, one for video and one for audio. 
Although these unique addresses look like TCP/IP addresses, they are not. Instead, they 
provide a way to define uniqueness among all multicast data flowing over the network. 
Once the broadcasting computer is streaming this data through the local network, any 
computer on the network can receive it.

The SDP file becomes the glue between your broadcast computer and the viewer 
computers. The SDP file contains multicast addresses, encoding format, and other 
important information.
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Record To disk
You can record your broadcast to disk at any time and you do not need to be 
broadcasting. This means that you can use Rich Media Desktop as a way to create 
movies to post on your Website. Record To Disk can be turned on or off, independent of 
your broadcast.

To configure Record To Disk, select Broadcast > Broadcast Settings (or press Ctrl+Y), 
then select Destination > Record To Disk. Click Browse to navigate to the file Rich Media 
Desktop will use to save your broadcast to disk. If you check the Auto Increment 
checkbox, your filename will be appended with an incremental number. This enables 
you to start and stop your broadcast repeatedly and save each movie segment in a 
uniquely named file. Click Save to save your settings:

Figure 76. Record To Disk Settings
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Flash Media Server
Rich Media Desktop can stream to an RTMP/H.264-compatible streaming server (Flash 
Media Server, Wowza Media Server, etc). But, Rich Media Desktop only supports H.264 
streaming over RTMP. Flash Players earlier than Flash 9, Update 3 (Dec 2007), may not 
be able to view the H.264 based streams.

To configure Flash Media Streaming, follow these steps:

1. Select a Flash preset from the encoder presets menu. 

2. Select Destination > RTMP Flash Server.

3. Enter the Address to the RTMP server. (This is the same as the FMS URL in Flash 
Media Server.) The default RTMP port is 1935, but you may need to configure your 
firewall to allow connections on this port.

4. Enter the name of the Stream to broadcast. (This is the same as the Stream in Flash 
Media Server.)

5. Rich Media Desktop can import a Flash Media Encoder configuration file (XML file). 
Click Open FMLE XML File, and navigate to the configuration file and select either 
version 2.5 or version 3.0. Rich Media Desktop will read the Address and Stream 
information from that file. Many online streaming services offer FMLE configuration 
files which Rich Media Desktop can use.

6. Click Save to save your settings:

Figure 77. Flash Media Settings

Note: Rich Media Desktop does not support alternative RTMP protocols (RTMPS, 
etc.), Vp6, or other Flash streaming codecs.

Note: Only the Address and Stream information from the XML configuration file is 
used. No Encoding information is imported.
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Click Save
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Flash To VBrick
To stream to VBrick, follow these steps:

1. Select a Flash preset in Encoder Preset. 

2. Select VBrick from the Destination menu.

3. Enter your VBrick username and click Authenticate. Rich Media Desktop 
authenticates your username, and enables you to stream to VBrick. If you do not 
have a username, click Sign Up (or go to www.vbrick.com) to sign up and obtain a 
username.

4. Click Save to save your settings. 

Figure 78. Flash to VBrick
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Flash Record To Disk 
Rich Media Desktop offers the ability to save your broadcast to disk as either a Flash or 
MPEG-4 file. To record your broadcast to disk, follow these steps:

1. To send to the QuickTime/Darwin streaming server, select Announce to QuickTime 
streaming server from the Destination menu.

2. Enter the path to your file, or click Browse to locate the file.

3. Check the Auto Increment Filenames checkbox (optionally), if you want your 
filename to have an incremental number appended to the end of it. This causes a 
new file to be created every time you start recording to disk. If you do not check this 
checkbox, then your previous file will be overwritten.

4. Select a File Type. You can choose either Flash (.F4V) or MPEG-4 (.M4V). 

5. Click Save to save your settings.

Figure 79. Flash Record To Disk Settings
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Annotation Settings 
Media players offer a feature which enables the viewer to see details about the 
broadcast they are viewing. These can be seen in QuickTime Player by selecting Show 
Movie Properties from the Movie menu. Select Movie, then Annotations, to see the 
details.

In Windows Media Player 10, the Title is used as the name of the broadcast in the Now 
Playing List. You can see the other properties by right clicking on the entry in the Now 
Playing List, selecting properties, then clicking the Content tab.

These Annotations can be configured for your broadcast in Rich Media Desktop. When 
you configure annotations, they apply for all streams at the same time. This means 
changing your annotations is very easy when you have multiple streams. To configure 
the annotations, follow these steps:

1. Select Broadcast Settings from the Broadcast menu (or press the Ctrl+Y keys). Select 
Annotations tab.

2. Enter the title and author of the broadcast.

3. Enter any copyrights the broadcast.

4. Enter any additional info associated with the broadcast.

5. Click Save to save your settings.

Figure 80. Annotation window
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Presets
Introduction
Rich Media Desktop supports a wide variety of encoders (also known as codecs).

An encoder is a program that compresses the audio and/or video output of Rich Media 
Desktop for broadcast. Without an encoder, the uncompressed data is too large to 
successfully broadcast across a network. This is why encoders are so important.

The settings for encoders range from simple to very complex. Because of this, Rich 
Media Desktop offers presets of the most common settings for encoders. This provides 
a starting point, reduces complexity, and enables you to experiment and adjust 
settings as you test your broadcast.

Topics
 The Encoder Presets Window

 Windows Media

 QuickTime Video

 QuickTime Audio

 Flash H.264

 Flash VP6
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The Encoder Presets Window
To open the Encoder Presets window, select Encoder Presets from the Window menu. 
The encoder presets menu at the top of the window provides a list of encoder presets. 
Select a preset to edit from this list.

Modifying Default Presets
It is best to leave all the existing presets in their default settings and create new ones as 
needed. This enables you to refer back to the standard presets at any time.

To create a new preset, you must make a copy of an existing preset. To do this select 
New from the encoder presets menu.

Figure 81. Encoder Presets window

Note: You can restore the encoder presets list to its factory default state at any time 
by selecting Restore Factory Presets from the encoder presets menu. However, in 
doing so you will delete any new presets that you have created.

Select New to create a 
new preset
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Windows Media
To modify a Windows Media encoder preset, follow these steps:

1. Open the Encoder Presets window

2. Select an encoder presets from the encoder presets menu.

3. Select Windows Media from the Output Format menu.

Figure 82. Windows Media Encoder Preset

4. Check the Video checkbox and select the Windows Media codec version to use.

5. Check the Audio checkbox and select the Windows Media codec version to use.

6. Use the Multiple Streams Panel (left side of window) to set up multiple simultaneous 
streams in a single encoder. This allows the media player receiving the stream to 
adjust it's quality depending on the connection speed and reliability. The plus and 
minus buttons at the bottom enable you add or remove additional streams to your 
preset.

7. Select the Audio Format. This is a pre-configured audio encoder setting.

8. Enter the Video Size. This sets the width and height of your resulting broadcast. 
Every stream should have the same aspect ratio. For example, if 640x480 is used, it 
has an aspect ratio of 4:3. Therefore, all other streams should also have a 4:3 aspect 
ratio.

9. Enter the broadcast frame rate in frames per second (FPS). This is a target rate and is 
only a goal for the encoder. It is not a guaranteed value. 

Multiple 
Streams 
Panel
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10.Enter the Key Frame Interval in seconds. This controls how often the encoder makes 
a new keyframe. The more keyframes your broadcast has, the more bandwidth it will 
take (since less compression can occur). However, more keyframes means motion in 
your video stream is better supported.

11.Enter the bit rate in Kbits (1000 bits) per second. This is a target setting for the 
encoder, not a guaranteed value. Higher numbers provide better quality - lower 
numbers, lower quality. The connection speed of your audience is a significant factor 
in determining your target bit rate. 

12.Set the smoothness using the slider. Video smoothness determines the trade-off 
between sharp images and smooth motion. Video appears smooth when objects 
move across the screen with non-jagged object edges. If you are dropping frames 
during encoding, consider decreasing video smoothness.

13.Select Complexity Some video codecs support multiple complexity levels. 
Complexity level does not directly affect the bit rate of a stream, but it can affect its 
quality. Complexity level is a measure of the processing power needed to 
reconstruct the compressed data.

14.Enter the buffer size. The bit rate and quality depends on the buffer size. A larger 
buffer size enables more bits to be allocated for complex video. For example, if you 
set the buffer size to 10 seconds, the codec may choose to allocate some bytes to the 
first 8 seconds and the rest during the last 2 seconds. Increasing the buffer will 
typically improve overall quality. For lower bit rates, it is recommended to increase 
the buffer size. For higher bit rates, increasing the buffer size has less effect.
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QuickTime Video
To modify a QuickTime video preset, follow these steps:

1. Open the Encoder Presets window.

Figure 83. QuickTime Video Encoder Preset

2. Select an encoder presets from the Encoder Presets encoder presets menu.

3. Select QuickTime from the Output Format menu.

4. Select the Video tab.

5. Check the Video Enabled checkbox. When checked, the video for your broadcast is 
encoded. When unchecked, a blank video screen is provided. This is the preferred 
method of producing audio-only broadcasts.

6. Select the encoder from the Encoder menu. The encoder is sometimes called a 
Codec or Compressor.

7. Click Options to view and/or set the encoder options. Many, but not all encoders 
provide optional settings. 

8. Select color depth from the Depth menu. Some Encoders allow you to modify the 
color depth (or bits per pixel) of the broadcast. Picking a higher color depth will 
result in larger output, but lower color quality. 

Note: Use a newly created preset (See Modifying Default Presets).

Note: If the Options button is greyed-out, no options are available.
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9. Enter the width of your broadcast video.

10.Enter the height of your broadcast video.

11.Select the quality of your broadcast by adjusting the slider between least and best. 
Generally, encoders make a trade-off between higher quality (greater bandwidth) 
and speed (CPU usage).

12.Select the desired fames per second (FPS) of your broadcast. This is a target value for 
the encoder and is not guaranteed.

13.Check Key Frame Every checkbox (optionally) and enter the number of frames. A 
movie is a sequence of images and each image is called a frame. To compress video 
data, most encoders take a frame and make it a reference (also known as a key). This 
keyframe is sent as part of the broadcast, and all of the data after that keyframe is 
relative to it. The benefit of this is that the compressor only needs to send what has 
changed since the last keyframe. The main drawback of this is that over time it 
becomes harder for the encoder to distinguish the frame-difference information, 
especially if there is a lot of motion in the video. Another drawback is if your viewer’s 
computer misses a keyframe, the video will be distorted until the next keyframe is 
sent. However, you can control how often the encoder makes a new keyframe by 
setting the number of frames. The more keyframes you broadcast, the more 
bandwidth required and less compression, but results in better quality video.

14.Check Average Bit Rate checkbox (optionally) and enter the average bit rate as a 
target setting. 

15.Check Limit Peak Bit Rate checkbox to request the encoder to limit the output to a 
specific rate.

16.Click the Packetize button to modify how the QTSS packets are created. This is an 
advanced feature for knowledgable users.

17.Click Save to save your settings.

Note: If the Quality scale is greyed-out, quality is a fixed value.

Note: Some encoders use this as a target value, not as an absolute value.
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QuickTime Audio 
To modify a QuickTime audio preset, follow these steps:

1. Open the Encoder Presets window.

Figure 84. QuickTime Audio Encoder Preset

2. Select an encoder preset from the Encoder Presets menu.

3. Select QuickTime from the Output Format menu.

4. Select the Audio tab.

5. Check (optionally) the Audio Enabled checkbox. When checked, the audio for your 
broadcast is included. When unchecked, audio is absent from your broadcast. This is 
the preferred method of producing video-only broadcasts because the presence of 
silent audio uses bandwidth.

6. Select the encoder to be used.

7. Click Options to view and/or set the encoder options. Many, but not all encoders 
have options that are specific to the encoder. 

8. Select the audio bit rate from the Rate menu. The higher the value you choose, the 
better the quality, but more bandwidth is required.

Note: Use a newly created preset (See Modifying Default Presets).

Note: If the Options button is greyed-out, no options are available.
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9. Select Bits Per Sample. This is how much data each sample of audio uses. The higher 
the value, the better the quality, but more bandwidth is required.

10.Select the number of channels: Mono or Stereo. Mono uses less bandwidth than 
stereo, but stereo is more pleasing to the listener.

11.Click Save to save your settings.
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Flash H.264
To modify a Flash H.264 preset, follow these steps:

1. Open the Encoder Presets window.

Figure 85. Flash H.264 Encoder Preset

2. Select an encoder preset from the Encoder Presets menu.

3. Select Flash from the Output Format menu.

4. Check the Video Encoding checkbox. When checked, the video for your broadcast is 
encoded. When unchecked, a blank video screen is provided. This is the preferred 
method of producing audio-only broadcasts.

5. Select the H.264 encoder from the Encoder menu.

6. Enter the width of your broadcast video.

7. Enter the height of your broadcast video.

8. Select the desired fames per second (FPS) of your broadcast. This value is a target 
value for the encoder and the exact value is not guaranteed.

9. Enter the average bit rate in Kbits (1000 bits) per second. This is the target bit rate of 
your video. Higher numbers provide better quality. The connection speed of your 
audience is a significant factor in determining your target bit rate. The encoder will 
compress the video to approximate this target. However, at different times during 
your broadcast the bit rate may be higher lower than the target rate.

Note: Use a newly created preset (See Modifying Default Presets).
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10.Select an encoder profile from the Profile menu. Two profiles are provided: Baseline 
and Main. The Baseline profile is commonly used in mobile applications. It is also 
used in other applications which operate with limited processing power, storage 
capacity, and/or bandwidth. The Main profile is appropriate for general-purpose 
applications of broadcast media, such as high-bandwidth Internet broadcasting.

11.Check Key Frame (optionally) and enter the number of frames. A movie is a 
sequence of images and each image is called a frame. To compress video data, most 
encoders take a frame and make it a reference (also known as a key). This keyframe is 
sent as part of the broadcast, and all of the data after that keyframe is relative to it. 
The benefit of this is that the compressor only needs to send what has changed since 
the last keyframe. The main drawback of this is that over time it becomes harder for 
the encoder to distinguish the frame-difference information, especially if there is a 
lot of motion in the video. Another drawback is if your viewer’s computer misses a 
keyframe, the video will be distorted until the next keyframe is sent. However, you 
can control how often the encoder makes a new keyframe by setting the number of 
frames. The more keyframes you broadcast, the more bandwidth required and less 
compression, but results in better quality video.

12.Check (optionally) the Timecode Every checkbox and enter the number of frames 
between timecodes. Rich Media Desktop can generate timecodes embedded in the 
flash stream. If a frames value of zero is entered, the timecode is never sent. Rich 
Media Desktop sends metadata along with the frames. This data looks like an onFI 
call. Various timecodes and timestamps are also sent with the stream.

13.Check (optionally) the Audio Encoding (AAC) checkbox. When checked, the audio 
for your broadcast is included. When unchecked, audio is absent. This is the 
preferred method of producing video-only broadcasts because the presence of 
silent audio uses bandwidth.

14.Select the number of channels: Mono or Stereo. Mono uses less bandwidth than 
stereo, but stereo is more pleasing to the listener.

15.Select the audio bit rate, in Kbits (1000 bits) per second, from the Target Bit Rate 
menu. This is the target bit rate of your audio. Higher numbers provide better 
quality. The connection speed of your audience is a significant factor in determining 
your target bit rate. The encoder will compress the audio to approximate this target. 
However, at different times during your broadcast the bit rate may be higher lower 
than the target rate. The total broadcast bit rate is a function of video bit rate plus 
audio bit rate.

16.Select the audio sample rate, in kHz (1000 Hz) per second, from the Sample Rate 
menu. This value specifies how many thousands of times per second to sample the 
audio in the broadcast. Higher values provide better quality sound, but at greater 
bandwidth.

17.Click Save to save your settings.
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Flash VP6
To modify a Flash VP6 preset, follow these steps:

1. Open the Encoder Presets window.

Figure 86. Flash VP6 Encoder Preset

2. Select an encoder preset from the Encoder Presets menu.

3. Select Flash from the Output Format menu.

4. Check the Video Encoding checkbox. When checked, the video for your broadcast is 
encoded. When unchecked, a blank video screen is provided. This is the preferred 
method of producing audio-only broadcasts.

5. Select the VP6 encoder from the Encoder menu.

6. Enter the width of your broadcast video.

7. Enter the height of your broadcast video.

8. Select the desired fames per second (FPS) of your broadcast. This is a target value for 
the encoder and is not guaranteed.

9. Enter the average bit rate in Kbits (1000 bits) per second. This is the target bit rate of 
your video. Higher numbers provide better quality. The connection speed of your 
audience is a significant factor in determining your target bit rate. The encoder will 
compress the video to approximate this target. However, at different times during 
your broadcast the bit rate may be higher lower than the target rate.

Note: Use a newly created preset (See Modifying Default Presets).
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10.Check Key Frame (optionally) and enter the number of frames. A movie is a 
sequence of images and each image is called a frame. To compress video data, most 
encoders take a frame and make it a reference (also known as a key). This keyframe is 
sent as part of the broadcast, and all of the data after that keyframe is relative to it. 
The benefit of this is that the compressor only needs to send what has changed since 
the last keyframe. The main drawback of this is that over time it becomes harder for 
the encoder to distinguish the frame-difference information, especially if there is a 
lot of motion in the video. Another drawback is if your viewer’s computer misses a 
keyframe, the video will be distorted until the next keyframe is sent. However, you 
can control how often the encoder makes a new keyframe by setting the number of 
frames. The more keyframes you broadcast, the more bandwidth required and less 
compression, but results in better quality video.

11.Check (optionally) the Timecode Every checkbox and enter the number of frames 
between timecodes. Rich Media Desktop can generate a timecodes embedded in 
the flash stream. If a frames value of zero is entered, the timecode is never sent. Rich 
Media Desktop sends meta data along with the frames. This data looks like an onFI 
call. Various timecodes and timestamps are also sent with the stream.

12.Check (optionally) the Audio Encoding (MP3) checkbox. When checked, the audio 
for your broadcast is included. When unchecked, audio is absent. This is the 
preferred method of producing video-only broadcasts because the presence of 
silent audio uses bandwidth.

13.Select the number of channels: Mono or Stereo. Mono uses less bandwidth than 
stereo, but stereo is more pleasing to the listener.

14.Select the audio bit rate, in Kbits (1000 bits) per second, from the Target Bit Rate 
menu. This is the target bit rate of your audio. Higher numbers provide better 
quality. The connection speed of your audience is a significant factor in determining 
your target bit rate. The encoder will compress the audio to approximate this target. 
However, at different times during your broadcast the bit rate may be higher lower 
than the target rate. The total broadcast bit rate is a function of video bit rate plus 
audio bit rate.

15.Select the audio sample rate, in kHz (1000 Hz) per second, from the Sample Rate 
menu. This value specifies how many thousands of times per second to sample the 
audio in the broadcast. Higher values provide better quality sound, but at greater 
bandwidth.

16.Click Save to save your settings.
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Presenter
Introduction
Desktop Presenter is a utility application that is provided free with Rich Media Desktop. 
Rich Media Desktop can broadcast the desktop of any computer on your local network 
as a live source. This topic describes how to use Desktop Presenter. 

Topics
 Downloading Desktop Presenter

 Launching Desktop Presenter

 Configuration with Bonjour Print Services

 Desktop Presenter Settings

 Adding Presenter Shots

 Parameters

 Applications
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Downloading Desktop Presenter
Desktop Presenter can be downloaded from:  Click here to download. Save the installer 
to your computer, then run the Installer and follow the instructions.
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Launching Desktop Presenter
Once Desktop Presenter has been installed, can be launched from Rich Media Desktop 
or launched stand-alone.

From the Application Program
To obtain live feeds from a computer desktop, Desktop Presenter must be launched on 
the target computer. To do this, select Launch Desktop Presenter from the Desktop 
Presenter menu in the Main window:

Figure 87. Launching Desktop Presenter
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Stand-Alone
To launch Desktop Presenter stand-alone (apart from Rich Media Desktop) select 
Desktop Presenter under Telestream in the Start menu on the desktop:

Figure 88. Launching Desktop Presenter Stand-Alone

Once Desktop Presenter is running, it can be paused or exited:

Figure 89. Running Desktop Presenter
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Configuration with Bonjour Print Services
If you are using Bonjour Print Services, Rich Media Desktop will automatically detect 
Desktop Presenter when it is launched on another computer. If either the Desktop 
Presenter computer or the Rich Media Desktop computer does not have Bonjour 
installed, then you will need to manually enter the TCP/IP address of the computer 
running Desktop Presenter. To do this select New Desktop Presenter from the Sources 
menu in at the top of the Rich Media Desktop Main window. Bonjour Print Services for 
Windows can be downloaded from:
http://www.apple.com/macosx/features/bonjour/. 

Note: Desktop Presenter uses port 7272. 
If you are using a firewall, this port must be open.
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Desktop Presenter Settings
Desktop Presenter is normally auto-detected by Rich Media Desktop and is 
automatically added to the list of sources. However, if a DTP is not detected, or if you 
want to add one in a remote location you can manually add it by selecting Sources > 
New Presenter from the menu in the Main window. 

You can then setup the presenter in the Source Settings window by entering an IP 
address of the target computer, optionally checking the With Audio checkbox, and 
clicking Apply:

Figure 90. Desktop Presenter Settings
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Adding Presenter Shots
You can now make a shot from the desktop presenter source. To do this, select Add 
Presenter Shot from the Desktop Presenter menu in the Main window. The new shot 
from the Desktop Presenter is displayed in the Main window area:

Figure 91. Add Desktop Presenter
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RMD User Guide | 81707 February, 2012



Using Desktop Presenter
Parameters

120
Parameters
In Desktop Presenter, select the Source of the desktop presentation: Main Display, 
Display 2, or Window. Optionally, you can check the 3D Compatibility and Capture 
Audio checkboxes if you are transmitting high motion video. During your presentation 
you can click Pause, which will interrupt the transmission to Rich Media Desktop, and 
then click Resume when you are ready to continue the presentation.

Figure 92. Desktop Presenter Parameters window

Pause/Resume button

3D Compatibility checkbox

Capture Audio checkbox
February, 2012 RMD User Guide | 81707



Using Desktop Presenter
Applications

121
Applications
Listed below are several typical applications of Desktop Presenter.

1. Lecture Hall/Board Room If a lecturer installs Desktop Presenter on a laptop, you 
can broadcast their PowerPoint or other presentation directly from that laptop. If the 
lecturer is demonstrating something using the laptop (like a 3D graphical 
animation), Rich Media Desktop can also broadcast this to viewers. Other programs 
including Excel also work perfectly with Desktop Presenter, allowing the speaker to 
spontaneously refer to data without having to create new slides.

2. Training As part of a training broadcast, you can switch to a live application to show 
exactly how to perform a particular action on a computer. This saves the laborious 
step of having to create screen shots of every minute detail.

3. Demonstration You can demonstrate your business process, software, or hardware, 
as part of a presentation. This can be done any time during a presentation by 
switching directly to the application program.

Note: Video games can be captured, but make sure your computer has sufficient 
speed and memory capacity.
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Using the Asset
Manager
Introduction
The Asset Manager is used to change the sources of media in your document.

Topics
 Documents

 Re-assigning Media
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Documents
Rich Media Desktop stores a path to your media in the Rich Media Desktop document. 
If you relocate your media, Rich Media Desktop will no longer be able to find them. In 
this case, use the Asset Manager to reassign the new media locations. However, Rich 
Media Desktop does keep track of the relative path to your media. If you move both the 
document and media to a new position, Rich Media Desktop will still find the media. 
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Re-assigning Media
To reassign media, follow these steps:

1. To open the Asset Manager, select Show Asset Manager from the Rich Media 
Desktop Media menu.

2. Click on the media you want to assign to another source.

3. Select the new media from the Assign To menu, or click Browse and locate the 
replacement media on disk.

4. Click Apply to replace the existing media, then close the Reassign Media window.

Figure 93. Reassign Media window

Note: When Desktop Presenter is selected as the source, you can enter the IP address 
to the Desktop Presenter. This enables you to build a Rich Media Desktop 
presentation with place-holders and then reconfigure at a later date to accommodate 
a new presenter with a new Desktop Presenter as a source. Additionally, if you select a 
camera input source from the Media List, an additional menu to set the Device Aspect 
Ratio of the camera is displayed. This is useful if the image aspect ratio of your camera 
is not automatically picked up by Rich Media Desktop. In this case, select the correct 
aspect ratio from the menu, click Apply, then click the corresponding icon in the Shot 
Selection.
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User Interface
Introduction
These topics describe the menus and menu items in Rich Media Desktop.

Topics
 File Menu

 Edit Menu

 Switch Menu

 Media Menu

 Sources Menu

 Broadcast Menu

 Layout Menu

 Window Menu

 Help Menu
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 File Menu
New. Creates a new, empty Rich Media Desktop document.

Open. Displays the Open dialog window for opening a Rich Media Desktop document.

Open Recent. Displays up to fifteen of the most recently accessed documents. Every 
time a document is opened or saved it is entered into the this list.

Import Media. Enables you to import media into Rich Media Desktop. A new shot is 
automatically created using the new media.

Canvas Size. Sets the canvas size aspect ratio used when broadcasting a Rich Media 
Desktop document.

Save. Saves the document. If the document has not already been saved, the Save As... 
dialog window is displayed.

Save As. Displays the Save As... dialog window so that the document can be saved 
using a new file name.

Close Window. Closes the currently active Rich Media Desktop window. If the window 
is a document, all of its Shot Editor windows are closed as well. If Rich Media Desktop is 
still broadcasting, asked to stop the broadcast. If the document has not been saved, 
you will be asked to save the document before closing.

Preferences. Opens the Preferences window. If the Preferences window is already 
open, it will be made active.

Exit. Closes all documents and then exits. If the broadcast is playing, you are asked to 
stop the broadcast. If a document has not been saved, you will be asked to save the 
document before exiting.

Note: You should match the output to the canvas size as close as possible to preserve 
video resolution and quality. For example, a 800x600 source will result in significant 
loss of quality if an aspect ratio of 640x480 is selected. Using 720x576, which is much 
closer in size, will help preserve video quality. 
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Edit Menu
Undo. Reverses your last change in Rich Media Desktop. Undo is only available in some 
windows (such as the shot editor). Rich Media Desktop offers an unlimited number of 
undo actions (within computer memory limitations). Undo information is stored on a 
per-window basis. Also, if you close window then reopen it, your undo information is 
lost.

Redo. Reverses your last undo action. Redo is only available in some windows (such as 
the shot editor). Rich Media Desktop offers an unlimited number of redo actions (within 
computer memory limitations). Redo information is stored on a per-window basis. Also, 
if you close window then reopen it, your redo information is lost.

Edit Shot. Opens the Shot Editor. (See Using the Shot Editor). You can also double-click 
a shot, or right-click and select Edit Shot, to open the Shot Editor. The Inspector window 
is a shot editor window which always edits the last touched shot. (See Inspector vs. 
Editor.)

Rename Shot. Enables you to rename a shot. You can also right-click a shot and select 
Rename Shot.

Duplicate Shot. Duplicates the currently selected shot. You can also right-click a shot 
and select Duplicate Shot.

Add Shot. Creates a new empty shot. You can also right-click a shot and select Add 
Shot.

Delete Shot. Deletes the currently selected shot. You can also right-click a shot and 
select Delete Shot.

Move To Layer. Moves a shot to the selected layer. When shots are created, they are 
assigned to a specific layer. They exist on that layer until they are moved or deleted. You 
can also right-click a shot and select Move To Layer. 
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Switch Menu
Go. Performs the same action as clicking the Go button.

Transitions. Rich Media Desktop has three transition buttons that can be assigned any 
transitions (cut, smooth, etc.) that Rich Media Desktop supports. The Switch menu lists 
the currently assigned transitions by name. These three transitions can also be selected 
by pressing the control key and either the 1, 2, or 3 key. (See Transition Controls to 
modify which transitions appear in this menu.)

AutoLive. Toggles (turns on and off) the AutoLive feature. It can also be toggled by 
changing checkbox AutoLive in the Main window. AutoLive is a fundamental feature of 
Rich Media Desktop which enables you to control how you make shots become part of 
the live broadcast. (See AutoLive.)
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Media Menu
Start Playing All Movies. Starts playing any movies that are not currently playing.

Pause All Movies. Pauses all movies that are currently playing.

Play to Next Point. Play all media to the next marker (point) that is embedded in the 
media. 

Jump to Previous Point. Forces all media to jump back to the previews marker (point), 
and then pause.

New Desktop Presenter. Launches the Desktop Presenter program. If Bonjour is not 
installed on the computer running Desktop Presenter, you may need to manually enter 
the TCP/IP address of that computer. If you want to add a Desktop Presenter before it is 
available you can use this menu option to pre-configure your document. You can also 
change the IP address to a Desktop Presenter in the Asset Manager dialog.

Show Asset Manager Opens the Asset Manager dialog window. (See Using the Asset 
Manager.)

Show Asset Manager. Displays devices that can be configured. Some devices 
(cameras, etc) may be configurable. For example, you can configure a USB camera to 
manually change its focus, contrast, brightness, etc. Other devices have multiple inputs 
you can choose (AlchemyTV Card, etc). 

Note: The Configure Devices menu selection is present only if a device is connected 
to Rich Media Desktop. The configuration user interface is provided by the device 
maker. It is beyond the scope of this document to describe all of the features available 
for all devices. See the documentation provided with your device on how to configure 
it.
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Sources Menu

New IP Camera. Opens the Source Settings window with IP Camera selected as a 
source. Enter the IP address and frame settings to test the camera, then click Apply to 
create the new source.

New Scoreboard. Opens the Source Settings window with a new (untitled) Scoreboard 
selected as a source. Configure the settings and click Apply to create the new source. 

New Presenter. Opens the Source Settings window with a new Desktop Presenter 
selected as a source. Enter the IP address and check With Audio to include audio from 
the desktop. Click Apply to create the new source.

Show Source Settings. Opens the Source Settings window. (See Using the Source 
Settings for more detailed information on setting sources.)

Show USB Devices. Opens a list of all USB devices.

PRO

PRO
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Broadcast Menu
Broadcast Settings. Opens the Broadcast Settings window.

Start/Stop Broadcasting. Starts (or stops) broadcasting to the network.

Start/Stop Recording. Starts (or stops) recording to disk. If you have not yet 
configured the Broadcast Settings for this document, you will be prompted to do so.

External Display Output. Selects an external display for the output of Rich Media 
Desktop. For example, if you have a projector connected to your computer using S-
Video, select it from this menu to display the output of Rich Media Desktop to the 
projector.

If you have a dual-head graphics card, you can select the second monitor to display 
Rich Media Desktop Output. However, if you have two graphics cards, Rich Media 
Desktop may not be able to display to any devices (monitors) on the second graphics 
card.
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Layout Menu
Preview. Shows (or hides) the Preview area in the Main window. You can also click the 
Preview icon in the Main window tool bar. 

Master Audio. Shows (or hides) the Master Audio controls.

Main Shot List. Shows (or hides) the main shot list.

Output Statistics. Shows (or hides) the output statistics.

Layer Panel. Shows (or hides) the layer panel.

Go to Layer. Displays the selected layer. The currently selected layer is always 
highlighted in the Layout Panel. You can also press Control + Shift keys with the T, F, N, 
B, or A keys to select a layer. Each of these letter keys represents a layer name: Title, 
Foreground, Normal, Background, and Audio
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Window Menu
Inspector. Opens the Inspector window. There is only one Inspector window for each 
document. The Inspector is very similar to the shot editor, except it always edits the last 
shot touched. 

Encoder Presets. Opens the Encoder Presets window.

Audio Inspector. Opens the Audio Inspector window.

New Layer Window. Opens a new Master Layer window for the layer selected.

Camera Preview. Shows a preview of all cameras currently connected to your 
computer.

Document Windows. All open document windows are listed at the bottom of this 
menu.

PRO
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Help Menu
Help. Opens the online help version of the User Guide.

Open PDF User Guide. Opens the PDF version of the User Guide.

Open Tutorial HTML. Opens the Rich Media Desktop Tutorial in your browser. To 
follow the tutorial, you'll need to Create a Document for the Tutorial as well.

Create Document for Tutorial. Creates a new Rich Media Desktop Document which 
contains the media necessary for following the Tutorial.

Report a Bug. Opens the VBrick Website bug reporting page where you can report and 
bugs you have encountered. Please give us as much detailed information as possible 
about your computer, what you were doing, and any supporting material regarding the 
problem. Additionally, if a specific piece of media is troublesome, please set it aside so 
that we can possibly obtain it and look at the problem directly. In the unlikely event 
that Rich Media Desktop crashes, you can also send us a debug log by clicking the 
Upload Debug Log File button in the File > Preferences > Advanced menu.

Provide Feedback. Opens the VBrick Website feedback page where you can enter any 
feedback you may have about our product or company.

Visit Web Site. Opens the VBrick Website home page.

Visit Desktop Presenter Download Page. Opens the VBrick Website download page 
for Desktop Presenter.

Acknowledgments. Opens on-line help to acknowledgments.

About. Displays version and copyright information about Rich Media Desktop
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Introduction
Rich Media Desktop is designed so that you can configure most of your options directly 
in your Rich Media Desktop document or the Shot Editor. The Preferences window 
enables you to set up Rich Media Desktop, set Desktop Presenter options, manage your 
licenses, update your software, and set advanced video options.

Topics
 Accessing Preferences

 General

 Register

 Licensing

 Software Update

 Advanced
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Accessing Preferences
To open the Preferences window, select Preferences from the File menu (or press the 
Ctrl+ Comma (“,”) keys). Preferences are grouped under five topics: General, 
Performance, Register, Software Update, and Advanced. Click one of these topics to 
view and change its preferences.

Figure 94. Preferences window

Rich Media Desktop automatically saves your preferences every time you make a 
change. The changes are immediately applied.

Resetting Preferences
To reset your preferences, quit Rich Media Desktop and then delete the files located at:

• Windows 7 and Vista: C:\Users\USERNAME\AppData\Roaming\Vara Software\Rich 
Media Desktop Preferences.

• Windows XP: C:\Documents and Settings\USERNAME\Application Data\Vara Soft-
ware\Rich Media Desktop Preferences 

Note: In some Windows directories, you may need to enable the Show Hidden Files 
option in order to view the folder containing the Rich Media Desktop Preferences file.
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General 
General preferences enable you to setup the Rich Media Desktop environment.

Figure 95. General Preferences

Open Last Document on Startup 
When checked, the last document you used will be opened when Rich Media Desktop 
starts up. Checked is the default.

Shot Editor Checkerboard
When checked, a checkerboard background displays in the Shot Editor to indicate the 
absence of color in the area where it is displayed. Checked is the default.

Feedback Detection
When checked, the computer audio is disabled (live feed is unaffected) whenever 
feedback is detected. Checked is the default. When feedback is detected, the following 
warning is displayed with an option to turn off feedback detection:
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Register 
Register preferences enable you to register and license Rich Media Desktop.

Figure 96. Register Preferences

Serial Numbers
The table in the Register Preference window displays the products and serial numbers 
that you have received for Rich Media Desktop.

To add a valid serial number, click the Add Button (“+” icon) below the table. When Rich 
Media Desktop displays the Enter Serial Number window, enter the serial number and 
click OK. Rich Media Desktop validates the serial number and unlocks Rich Media 
Desktop. If you previously purchased a copy of Rich Media Desktop and want to use 
that serial number, enter that serial number to unlock Rich Media Desktop.

Add button

Note: The serial number is always composed of numbers and upper case letters 
(excluding upper case letter O), but it never contains quotation marks. When you 
receive a serial number, it may be enclosed in quotation marks (e.g., “123-456-789”). 
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Licensing
To purchase a serial number for Rich Media Desktop, or Rich Media Desktop Pro, please 
contact VBrick at (203) 265-0044. You may also make purchases through Rich Media 
Desktop. To do this select the Register tab, click the Add button (“+” icon), then click 
purchase in the Resultant window. This directs you to the VBrick Website where you can 
submit your purchase request directly.

Deactivate Serial Numbers
Deactivating a serial number allows you to re-activate it on another computer. You can 
always reactivate a serial number by re-entering it. To deactivate a serial number, select 
an activated product, and click the minus [-] button. Rich Media Desktop deactivates 
the serial number, disables Rich Media Desktop, and adds water-marking to the video 
and audio. When you deactivate a serial number, it is removed from the table.

Demonstration Mode
When no serial number is entered or activated, Rich Media Desktop water-marks all 
output (both to disk and network). The video water-mark is a periodic overlay of the 
Rich Media Desktop logo. Audio water-mark is a periodic voice over. If you have a Rich 
Media Desktop serial number and are using a Rich Media Desktop Pro feature without a 
Pro license, that output is also water-marked.
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Software Update 
Software update preferences enable you to obtain Rich Media Desktop updates.

Figure 97. Software Update Preferences

Automatically Check Updates
Check the Automatically Check For Updates checkbox to cause Rich Media Desktop to 
check for updates on the VBrick Web site each time Rich Media Desktop is launched. No 
personal information is transferred to VBrick during this action. Checked is the default.
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Advanced 
Advanced preferences enable you make advanced settings for Rich Media Desktop.

Figure 98. Advanced Preferences

Use High Quality Video
Check the Use High Quality Video checkbox to increase the quality of decoding 
performed on your source media files. (See Output Statistics for information on output 
statistics.) If CPU usage is near 95%, or if the frames per second (FPS) is consistently well 
below your target, uncheck UseHigh Quality Video to remedy this. Checked is the 
default.

Use GPU Compression
On appropriate hardware, Rich Media Desktop can gain significant speed 
improvements by using your graphics card to pre-process frames before sending them 
to the encoders. Uncheck the Use GPU Compression checkbox only if you experience 
issues with your encoded output. This option is included in the rare case that you 
choose to use an Encoder that does not support the necessary features. Rich Media 
Desktop has been designed to work with all encoders, but there is no guarantee that all 
encoders are compatible. Checked is the default.

Upload Debug Log File
Occasionally, VBrick may require detailed debugging information to help understand 
issues you have reported. At the request of customer service (or support), click the 
Upload Debug File button to upload a text file to our server for our engineers to review. 

Note: Note: Capture Device Size has been moved to the Source Settings window.

Note: Use this feature only under direction of our customer service or support staff. 
No personal information is transmitted.
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Window
Introduction
This section describes in detail how to use Rich Media Desktop’s main window.

Topics
 Introduction

 Window Bar Buttons

 Preview / Live Area

 Transition Controls

 Tool Bar

 Shot Selection Area

 Layers

 AutoLive
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Introduction
Rich Media Desktop’s main window is comprised of six display areas: 

1. Window Bar Buttons The top area with the Broadcast and Record buttons.

2. Messaging Area The area just below the window’s tool bar.

3. Preview/Live Area The large area in the center.

4. Transition Controls The area with the transition (Cut, Smooth, and Bowstring) and 
Go buttons.

5. Toolbar The toolbar containing six tools located just above the Shot Selection area.

6. Shot Selection Area The area displaying the shot icons (available shots).

Figure 99. Main Window

Window toolbar buttons

Messaging area

Preview/Live area

Transition controls

Shot selection area

Toolbar
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Window Bar Buttons
Rich Media Desktop provides four Window Bar buttons: Broadcast, Record, Preview, and 
Inspector.

Figure 100. Window Bar Buttons

• Broadcast The Broadcast button starts and/or stops the broadcast. If you have not 
yet configured the broadcast, clicking this button brings up the Broadcast Settings 
window. This button is independent of the Record button. You can turn broadcast-
ing on and off regardless of whether you are currently recording the broadcast.

• Record The Record button starts and/or stops recording. If you have not yet config-
ured the broadcast, clicking this button brings up the Broadcast Settings window. 
This button is independent of the Broadcast button. You can turn Record on and off 
regardless of whether you are currently broadcasting.

• Preview Shows or hides the Preview area. The Preview area shows what the live 
broadcast will look like after you click the Go button. The Preview is not very useful 
unless you turn off the AutoLive feature. When Preview is open it is displayed as the 
left panel of the Preview/Live area, and displays a green P in the top-left corner of the 
preview window.

• Inspector Opens the Inspector window. The inspector is very similar to the editor 
window, but the Inspector always shows the last shot selected.

Broadcast button

Record button Preview button
Inspector button
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Preview / Live Area
When you open a new document, only the Live area displays. The Live area shows what 
is broadcast to your viewers before the encoding or compression. 

When AutoLive is off, you can make several changes without your viewers seeing the 
change. This is most useful when you are using an engineer to run your broadcast. 
When you are making changes to your broadcast, you may want to see those changes 
before broadcasting them. Preview allows you to do this.

To see the preview, select Preview from the Layout menu. This sets up the Main 
Window with Preview on the left and the live broadcast on the right. Clicking the Go 
button makes the Ripples shot become Live.

Figure 101. Preview and Live Displays
Preview display Live broadcast display
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Transition Controls
The transition area is in the middle of the Main Window: 

Figure 102. Transition Controls

There are three Transition buttons, but each can be configured to present one of many 
possible transition types. In the image above, the three configured transitions are: Cut, 
Smooth, and Bowstring. Since Smooth is selected (button darkened), any transition 
executed by clicking Go will be a smooth transition. 

Changing Transitions
If you single-click the Bowstring button, it will become selected and making it the 
current transition type: 

Figure 103. Bowstring Transition Control

You always have three different transition types available. You can also select one of the 
three buttons by pressing Ctrl+1, 2, and 3 keys for the three transition types displayed.

If you click the down-arrow on the right side of any transition button, you can select a 
new transition to be assigned to that button. In the image below, Swoop has been 
assigned to the first transition button:

Figure 104. Swoop Assigned to First Transition Button

Transition Time
The duration of the transition is controlled by clicking the duration icon: 

Figure 105. Duration Icon

This button controls the duration of all transitions, except for Cut which is immediate. 
For example, if you click the Duration button and select Slow from the drop-down 
menu, the button changes to display a turtle icon.

Figure 106. Slow Duration (Turtle) Icon
RMD User Guide | 81707 February, 2012



Using the Main Window
Transition Controls

150
Additionally, if Slowest is selected a bug is display, and if Fast is selected a rabbit is 
displayed.

Go Button
The Go button (or you can press the Ctrl+G keys) will take any changes you have made 
and make them Live using the selected transition and duration. However, the Go 
button only becomes important when you have AutoLive turned off. This is because 
when AutoLive is on, every time you click a shot the Go action is automatically 
executed for you. (See AutoLive.)
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Tool Bar
The Toolbar provides a way to open lives sources, file sources, the Desktop Presenter 
program, shot graphics, shot audio, and shot templates.

Figure 107. Toolbar Tools

Live Sources 
Click the Live Sources button to display a list of live sources under the categories: 
System Device, IP Camera, Pipeline, and Scoreboard. When a live source is select, it is 
added to the Shot Selection area as a new shot.

File Sources 
Click the File Sources button to display a list of file-based sources categories: Video 
Shots, Picture Shots, Music (audio) Shots, or a New (empty) Shot. When selected a file 
selection dialog window will display enabling you to navigate to and select a file to 
become a shot. Select Add New Shot to add a new, untitled, generic shot without any 
file-based resources attached.

Desktop Presenter 
Click the Desktop Presenter button to select one of three actions: launch Desktop 
Presenter, add a new Desktop Presenter shot, or configure an existing Desktop 
Presenter shot. You cannot configure an existing shot until the Desktop Presenter is 
open.

Shot Graphics
Click the Shot Graphics button to select one of three actions: Source A, Untitled 
Scoreboard, the current Desktop Presenter shot, add a picture from disk, or add a movie 
from disk. When a selection is made, the source selected is added to the Shot Area as a 
new shot.

Live Sources
File Sources

Shot Graphics
Shot Audio

Desktop Presenter Shot Templates

Note: When you click the Desktop presenter button, there is a slight delay until the 
menu selections are displayed.
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Shot Audio
Click the Shot Audio button to add an audio file shot. When selected a dialog window 
will display enabling you to navigate to and select a file.

Shot Template
Select a shot in the Shot area, then click the Shot Template button to select a template 
to be applied.
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Shot Selection Area 
The bottom part of the Main Window contains the Shot Selection Area, also called the 
Shot List. 

Figure 108. Shot Selection Area

Changing Shots
You can change shots by clicking on the one you want to activate. Above, Ripples is 
selected as the current shot. You can add a new empty shot by right-clicking on any 
existing shot displayed in the Shot Area.

Delete Shot You can delete a shot by right-clicking it and selecting Delete Shot, or by 
selecting Delete Shot from the Edit menu. You can also delete a shot by selecting it and 
pressing the Ctrl+Backspace keys.

Edit Shot You can edit a shot by double-clicking on it, by right-clicking it and selecting 
Edit Shot, or by selecting Edit Shot from the Edit menu. You can also edit a shot by 
selecting it and pressing the Ctrl+E keys.

Duplicate Shot You can duplicate a shot by right-clicking it and selecting Duplicate 
Shot, or by selecting Duplicate Shot from the Edit menu. You can also duplicate a shot 
by selecting it and pressing the Ctrl+D keys.

Rename Shot You can rename a shot by right-clicking it and selecting Rename Shot, or 
by selecting Rename Shot from the Edit menu. You can also rename a shot by selecting 
it and pressing the Ctrl+R keys.

Moving a Shot to Another Layer
You can move a shot to another layer by selecting Move to Layer from the Edit menu, 
then selecting the target layer from the drop-down menu. You can also right-click the 
Shot and selecting Move to Layer. When shots are created, they are assigned to a 
specific layer. They exist on that layer until they are moved or deleted. (See Layers.)

Growing/Shrinking the Shot Thumbnails
In the lower right corner of the window is a slider you can use to control the size of the 
shot thumbnails. Drag the slider to the left to reduce the size of the thumbnails and to 
the right to enlarge them.

Shot selection area
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Layers 
Rich Media Desktop allows you to put shots on any of five different layers. Layering 
shots enables Rich Media Desktop to merge them together, from back (lowest layer) to 
front, to form a single visual image during broadcast. 

When Rich Media Desktop first opens, the Layer panel is not shown. To display the layer 
panel, select Layer Panel from the Layout menu, or click the grey strip (on the left end of 
the Shot Area) and drag it to the right. 

Figure 109. Layer Panel Display

What is a Layer? 
Layers are, by default, named Master Layer 1 through 5. You can change the name of 
any layer by double-clicking it and entering a new name (i.e. Background, Camera, etc.). 
Layers determine the order when presenting images in the live broadcast area. The 
Bottom layer (Master Layer 5) is drawn first, then the other layers, in order, up to Master 
Layer 1. You should name your layers according to the function they serve. Examples 
might be: Audio, Background, Normal, Title, etc. 

Using multiple layers is a powerful way to show, for example, a company logo, or a 
beautiful background, or title, independently from each other. You could have a shot of 

Layer Panel
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your logo on a “Title” layer (the top layer), so that it will always be visible, above all other 
layers placed behind (below) it.

Changing Layers
To view other layers, click in the Layer Panel on the name of the layer you want to 
display. When a new layer is selected, the Shot list changes to display the shots that are 
in that newly selected layer.

Figure 110. Changing Layers

Moving a Shot to Another Layer
A shot can be moved to another layer by selecting Move to Layer from the Edit menu, 
or right-clicking on the shot and selecting Move to Layer. When shots are created, they 
are assigned to a specific layer. They exist on that layer until you move them or delete 
them. 

Note: There are key-press short-cuts available to help you quickly change layers. 
These short-cuts remain the same even when you change the name of a layer.

Click layer name to 
select a layer
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AutoLive 
The AutoLive button is located in the Transition Controls, just left of the Go button. 
Clicking on the AutoLive button toggles it between on and off. When AutoLive is on, 
the button will display a green dot. You can also select AutoLive from the Switch menu.

When AutoLive is on, changes made in the Main Window automatically go to live 
broadcast. If you click a shot when AutoLive is on, the shot is automatically taken Live 
for you in the broadcast (using the current transition and duration). If you click a shot 
when AutoLive is off, the shot is not sent to live broadcast. In this mode you take the 
shot live manually, by clicking the Go button, or by pressing the Ctrl+G keys.
February, 2012 RMD User Guide | 81707



157
Using the Audio
Inspector
Introduction
The Audio Inspector enables you to monitor and control all of the audio sources from a 
single control panel. This section describes in detail how to use the Audio inspector.

Topics
 Introduction

 Hardware Audio

 Shot Audio
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Introduction
To open the Audio Inspector panel, select Audio Inspector from the window menu.

The Audio Inspector separates your audio by hardware and shot. Live Input is always 
the first section to the right of the Master control, and it contains all hardware audio 
sources you may be using. This includes microphones, audio input feeds, cameras, 
capture cards, Pipelines, etc. The remaining audio controls are associated with specific 
shots. 

Figure 111. Audio Inspector panel.

Hardware Audio and Shot Audio
The Master control sets and displays the total audio output of your broadcast. Click the 
headphones icon (directly below the Master controls) to mute the local audio feed. 
(This has no effect on the broadcast audio output.) The Mute button, below the 
headphones icon, mutes all local audio and all broadcast audio.

Below the name of each audio source is a white label box. You can rename this box to 
as appropriate for the source, to avoid confusion during a broadcast. To rename the 
audio source, click in the white box and enter the new name.

Hardware audio sources are automatically added to the Audio Inspector whenever a 
new audio source is added through the Main window or through the Shot Editor. You 

Note: The use of the Audio Inspector requires a Rich Media Desktop Pro license. For 
licensing information, select Preferences from the FileRich Media Desktop menu, click 
the Add (+) button, then click Purchase. 

PRO

Master Audio control panel

Master Audio level control 

Master Audio level display

Headphone Mute icon
Master Mute button
February, 2012 RMD User Guide | 81707



Using the Audio Inspector
Introduction

159
can also manually add a hardware audio source by clicking the Live Input drop-down 
menu at the top of the Live Input section.

Figure 112. Audio Inspector
Live Input control

Shot control

Label box

Live Input drop-down 
menu
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Hardware Audio
Hardware audio sources are hardware devices and live sources. This includes dedicated 
microphones, cameras (that have audio), audio line feeds, Pipelines, capture cards, etc.

Figure 113. Audio Delay Control

When you add a device to the Audio Inspector as a Live Input, it defaults to the lowest 
volume level, because all Live Input audio sources act as global audio sources through 
the Audio Inspector. Thus, any source listed in the Live Inputs section can be 
immediately added to a broadcast by dragging the volume slider on that source up.

The horizontal slider in a Live Input controls the audio delay. Dragging the slider to the 
right will increase delay, up to one second, to fine-tune audio in sources where the 
audio is ahead of the video.

Note: Audio that is out of sync with video is common when running a microphone 
directly into your computer's audio input when using a FireWire camera as a video 
source. Most FireWire devices create a latency that causes the audio to be ahead of 
the video.

Audio Delay control
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Shot Audio
Shot audio sources come from shots that are currently live in your Rich Media Desktop 
document. Any time a shot becomes live, it immediately displays in your Audio 
Inspector.

Adding Shot Audio Sources
The Shot Audio panels are always displayed to the right of the Live Input panel in the 
Audio Inspector. Shot audio is automatically added to your broadcast whenever a shot 
containing audio transitions to live broadcast. 

New Shot Audio controls are created as multiple shots are made live during the 
broadcast. For example, if you have live shots with audio sources in Master Layer 1, 2 
and 3, Rich Media Desktop displays three Shot Audio panels. Each panel provides you 
to control the audio output of the source it controls.

Managing Audio Sources
Shot audio is most useful in controlling the audio levels during a live broadcast. You can 
use the sliding meters to adjust the volume levels of any source during broadcast. If a 
source begins contributing audio that is wrong or distorted, you can click the Mute 
button at any time to silence it. Its muted state is maintained even if you change shots 
and come back to it.
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Settings
Introduction
These topics describe how to use the Source Settings editor.

Topics
 Overview

 System Devices

 Scoreboards

 IP Cameras

 LiveU

 Capture Cards
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Overview
To open the Source Settings window, select Sources > Show Source Settings. 

The Source Settings window is divided into several sections: system devices, Preview 
window, configuration area, and button bar:

• The Source List displays all the devices detected by Rich Media Desktop (USB and 
FireWire devices, microphones, line inputs, Webcams, etc). Sources to be used are 
selected from this list.

• The Preview window provides a preview of the video coming from a selected source. 

• The Configuration Area is for configuring sources. When a source is selected from the 
System Devices list, the configuration options for that source are displayed.

• The Button Bar contains two buttons. Click the plus (+) button to manually add new 
sources. Click the minus (-) button to remove them.

Figure 114. Source Settings Editor

Note: All sources listed in the Source Settings window are also accessible through 
the Add Live Source button in the Main window Toolbar.

Note: In Rich Media Desktop versions 4.0 and above, de-interlacing has been moved 
from System Preferences (where it was a global setting) to the Source Settings, where 
it is individually controlled by each device.

Source List

Configuration Area

Preview window

Button Bar
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System Devices
System devices include Firewire devices, USB cameras, and other USB devices. Click on 
a device to select it. Two drop-down menus and a configuration button are displayed. 
The Capture Device Size menu selects the device resolution from 160x120 to 1920x1080, 
depending on the camera. The Device Deinterlacing menu selects either None or 
Blend. None turns of deinterlacing enabling the video to interlace normally. Blend turns 
deinterlacing on enabling the video to avoid interlacing problems during motion. Click 
Configure to configure the selected device.

Figure 115. System Devices Settings

When you click Configure, a properties window displays with two tabs. The Video Proc 
Amp tab enables you to set the video display properties. The Camera Control tab 
enables you to set camera image properties. Any properties that do not apply to the 
selected camera are greyed-out. 

Figure 116. System Device Configuration Properties

Select a device

Select resolution

Click to configure 
device
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Scoreboards

Scoreboards allow you to add a scoreboard graphic to your broadcast that can by 
dynamically updated. To add a new scoreboard, select New Scoreboard from the 
Sources menu. Multiple scoreboards can be added. 

When a scoreboard is opened in the Source Settings editor, it displays a preview of the 
scoreboard, two drop-down menus, and two configuration tabs.

Figure 117. Scoreboard window

Unlike most other elements in Rich Media Desktop, changes to the Scoreboard go live 
instantly without requiring a transition. Once the scoreboard is live, the preview image 
is exactly as it is seen in your broadcast.

Of the two drop-down menus, the first selects the style of the scoreboard (Pipe, Shade, 
Corner, Wide, etc.) and the second selects the scoreboard layout (Basic, Top, Bottom, 
etc.). Some layouts change the number of fields surrounding the scoreboard, allowing 
additional live information to be added.

The Data Tab
The Data tab configures the information displayed inside your scoreboard. The first two 
lines of data hold the name and score of each team. Before broadcasting, you should 
enter the names of each team here. While the broadcast is live, click the “+1”, “+2” and 
“+3” buttons to modify the score.

There are also four information fields (Field 1 through 4). Each field controls a line of 
text inside the scoreboard that can be seen using the various layout types.

PRO

Preview

Drop-down menus

Configuration tabs 

Note: Because Rich Media Desktop updates the scoreboards dynamically, It is 
recommended that you fill in the additional information fields while using a layout 
that hides them. Then, change to a layout that reveals those fields when ready, 
otherwise your viewers will see you typing in those fields live.
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Figure 118. Scoreboard Data Tab

The Look Tab
The Look tab controls the visual elements of your scoreboard. In the Name Options 
column, there are three buttons for each field. These buttons enable you to change the 
text alignment, font style and text color respectively. The Score Options (on the right 
side) provide the same three adjustments to the score.

Some scoreboard styles also allow you to change the background colors of the Home 
and Visitor fields, to make them match their team color. This option, when displayed, is 
located between Name Options and Score Options.

Figure 119. Scoreboard Look Tab

Information field 
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Style menu

Data tab 

Layout menu

Teams names
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Text color
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IP Cameras

IP Cameras are devices indirectly connected to your computer, made available across a 
network connection. Most supported IP Cameras will be detected automatically. 

To enable the use of an IP camera and create a shot using it, you must first add it to Rich 
Media Desktop. To do this select an IP camera from the Add Shot menu in the Main 
Shot List window:

Figure 120. Adding an IP Camera

IP Cameras are usually auto-detected by Rich Media Desktop, but if not detected it can 
be manually set up. To do this, select an Add IP Camera from the Sources menu in the 
Main window. Then, in the Source Settings window, select an IP camera from the list of 

PRO

Select an IP 
Camera

Click Add Shot 
menu
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devices, enter the IP Address of the camera, optionally check Use Audio, and click 
Apply:

Figure 121. Setting Up an IP Camera

When Use Audio is checked, audio from the camera is used if the camera has a 
microphone. 

Some supported IP Cameras also have motion controls (directional arrows) that enable 
you to move the camera in different directions.

Note: When a IP Camera has been auto-detected, the IP Address field is greyed-out.

Apply settings

Check Add Audio 
(optionally)

Enter the IP 
Address

Select IP 
Camera
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LiveU
LiveU is a portable, video-over-cellular, video uplink system. LiveU uses a video encoder 
and a series of parallel cellular modems to transmit video. LiveU uses high-profile H.264 
encoding to provide uninterrupted video streaming from anywhere, directly to Rich 
Media Desktop as a live camera source.

You can also send Rich Media Desktop output directly in to LiveU for transmission to 
another broadcast destination.

For more information about LiveU, see www.liveu.tv.

Using LiveU as a Source
Follow these steps to set up and use LiveU as a live camera source.

Install and Configure LiveU Software
First, download and install the LiveU server software provided by LiveU. Follow the 
instructions provided by LiveU to configure the software to connect with your LiveU 
backpack.

Next, click the Configuration tab. 

Figure 122. Setting Up LiveU

Select the Output Media drop-down menu and select Local and click the Apply button. 

Note: LiveU can only be used with Rich Media Desktop for Windows.

Select Local from the 
Media dropdown 
menu

Click the 
Configuration tab

Click the Start 
button
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Start Transmitting Video
Press the Start button. LiveU displays a LiveU Player window without any content 
displayed. Do not close this window, just move it out of the way.

Now, check the status field at the bottom of the window, and wait until you observe 
data being received – LiveU displays "Received Rate <current rate>" in this field.

Start and Configure
Now, start Rich Media Desktop.

Figure 123. Setting Up Rich Media Desktop

The LiveU source displays under the Add Live Sources drop-down menu as liveu_[your 
unit name].

The audio source is named liveu_[your unit name]_audio. Add both of these sources 
to a single shot to begin using your LiveU backpack with Rich Media Desktop.

Using LiveU as an Output
Configure LiveU to stream to the destination of your choice. 

Next, connect your Rich Media Desktop computer to your LiveU backpack using a DVI, 
VGA, or HDMI connection. For VGA and DVI, you need to run an audio cable from your 
computer's audio out in to the LiveU backpack. 

Open Rich Media Desktop and enable External Display Output on the LiveU unit.

Note: If you encounter issues connecting your LiveU unit to the LiveU server 
application, contact LiveU support at www.liveu.tv/support.html.
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Now, Rich Media Desktop will send video in to LiveU as though it were a camera. The 
Rich Media Desktop output can be re-broadcast or sent straight to a Web destination.
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Desktop Presenter
The Desktop Presenter is a utility application that enables Rich Media Desktop to 
broadcast the desktop of any computer running Desktop Presenter.

Desktop Presenter is normally auto-detected by Rich Media Desktop and is 
automatically added to the list of sources. However, if a DTP is not detected, or if you 
want to add one in a remote location you can manually add it by selecting Sources > 
New Presenter from the menu in the Main window. 

You can then setup the presenter in the Source Settings window by entering an IP 
address of the target computer, optionally checking the With Audio checkbox, and 
clicking Apply:

Figure 124. Desktop Presenter Settings

For more information, see Using Desktop Presenter.

Note: When a Desktop Presenter has been auto-detected, the IP Address field is 
disabled.

Select Presenter

Enter IP Address

Check With Audio 
(optionally)

Click Apply

Desktop Display
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Capture Cards 
Capture Cards are hardware extensions that enable you to bring in video from more 
advanced HDMI and SDI sources. Most capture cards are automatically configured to 
the best settings. Some cards (Blackmagic Intensity Pro, for example) require some 
manual adjustments. When a Capture Card is selected, you can select the Frame 
Format. Clicking Save will cause the video to display. You can also check the De-
interlacing checkbox to turn on de-interlacing. Once configured, you can add Capture 
Cards from the Live Source drop-down menu in the Main window. 

If you experience difficulty with your Capture Card, make sure you have the latest driver 
from the vendor and that it is installed correctly before contacting Customer Support.

Figure 125. Capture Cards

Capture cards supported by Rich Media Desktop:

• Blackmagic Intensity Pro

• Blackmagic Decklink Studio

• Blackmagic Decklink SDI

• Blackmagic Decklink Duo

• Blackmagic Decklink Extreme 3D

• Osprey 240e, 450e, 700e

• Matrox Multi

Frame Format

De-interlacing

Save
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Show USB Devices 
To view a list of all USB devices select Show USB Devices from the Sources menu. The list 
displays all connected USB devices, the USB bus on which each USB device is located, 
and the speed of the device. Click Show All Devices to display all available USB devices, 
otherwise only video devices are listed. Click Refresh to update the list. 

Figure 126. Show USB Devices
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Using the Shot Editor
Introduction
The Shot Editor is used to view a shot, edit it, or create a new one. This section describes 
how to use the Shot Editor.

Topics
 Shot Editor Layout

 Sources

 Shot Editor Preview

 Shot Editor Media Panel

 Shot Editor Effects

 Shot Editor Cropping

 Shot Editor Chroma Key

 Shot Editor Motion

 Shot Editor Playback
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Introduction
There are three ways to open the Shot Editor: select Edit Shot from the Edit menu, 
double-click on a shot, or right-click a shot and select Edit Shot.

Figure 127. Three Ways to Edit a Shot

The Inspector
You can also edit a shot using the Inspector. The Inspector is opened by selecting 
Inspector from the Window menu. It can also be opened by clicking the blue Inspector 
icon (contains the letter “i”) on the far right side of the window bar at the top of the 
Main window.

Window Bar buttons

Messaging area

Preview/Live area

Transition controls

Shot selection area

Toolbar
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When the Inspector opens, if the shot you want to edit is not displayed (or no shot is 
displayed), single-click a shot in the Main window shot list to open one. The Inspector 
immediately displays the shot so you can edit it.

Figure 128. Inspector window

Activating Changes
Rich Media Desktop always displays your visual changes in the preview panel. However, 
your changes only become Live when you specifically click Go (or press the Ctrl+G 
keys).

The AutoLive feature does not apply when using the Shot Editor.

Inspector vs. Editor 
A shot can be edited in two ways: You can double-click on the shot and open an editor 
specifically for that shot, or you can open the inspector window and then click the shot 
you want to edit. Both windows displays the same set of controls. The only difference is 
that the Editor window displays a specific shot and the Inspector window displays all 
the shots that can be edited. Additionally, you can display and edit shots in both the 
Shot Editor and the Inspector at the same time.

If no shot is currently selected, Inspector buttons and other GUI elements are not 
functional. To select a shot for editing, single-click a shot in the Shot List panel at the 
bottom of the Main window.

Note: The exception to this occurs in the Playback Panel where you can specifically 
make your changes become live.
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Shot Editor Layout 
The Shot Editor is comprised of four major sections: Preview Area, Source List, 
Attributes Toolbar, and the Attributes Editor Panel.

Figure 129. Shot Editor window

The preview area displays a preview of how the shot will look. As you edit a shot by 
changing its attributes, visual changes are displayed in the Preview area.

The Source List is a list of sources (live sources, images, and title banners) currently in 
the shot. Rich Media Desktop enables you to put up to seven sources in each shot. You 
add and delete sources by clicking the plus (+) and minus (-) icons in the toolbar at the 
bottom of the Source List. Click a source in the list to edit it. Sources are layered in the 
shot, from top to bottom on the list. You can reorder sources using the up and down 
arrows in the toolbar below the list, or right-click the source and select Move Up or 
Move Down. (See Sources.)

The Attributes Editor Panel displays each of the configuration panels. At the top is an 
Attributes toolbar for configuring each category of attributes. To view or edit a given 
attribute category, click the appropriate icon in the Attribute Toolbar. The attributes 
change depending on the type of source (live source, graphics, audio, etc.) currently 
selected.

Preview 
Area

Source 
List

Attributes 
Editor 
Panel

Attributes 
Toolbar
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Sources 
Sources are specific resources made available to Rich Media Desktop that include 
configuration settings. These sources can be titles, a live camera feeds, graphics, etc., 
and they are incorporated into shots used in a broadcast. You can place up to seven 
sources in a shot, where they are placed as layers that reside in front or in back of each 
other.

Templates
Rich Media Desktop also provides pre-built source sets, called templates, which you can 
add to your source list. Templates are pre-defined configurations used for displaying 
the sources of a shot. The templates contain place holders, labeled A, B, and C, that 
define where the sources in a shot are located. For example, you can select a two-
source template that displays one element in full-screen and another, superimposed in 
the bottom left corner. When a different template is selected for the shot, the sources 
stay the same but their locations are redefined.

Templates provide an easy way to add several sources to a shot, all pre-arranged and 
organized in popular scale, angle, and position patterns (left/right, stacked, 
superimposed, etc.). Some templates have a single place-holder, some have two, and 
still others have three.

To add a set of template-based sources to your shot, click the Add Presets button to the 
right of the Sources List title. 

Figure 130. Add Presets Button
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Rich Media Desktop displays a Template window with two tabs: Templates and Virtual 
Sets. Click the Templates tab and select the template you want to use, then click Apply. 

Figure 131. Template window

The Preview has changed in the Shot Editor window, and now shows the Ripples image 
on the Left side. This is because the template selected has an A and a B portion to it. 
Two different sources can be assigned to A and B:

Figure 132. Shot Using Template

Sources in Rich Media Desktop can be assigned either A, B or C in the Source Layers list. 
To change the assignment, click the A (or B or C) icon and make a selection. This makes 
choosing a new template much simpler because Rich Media Desktop automatically 
positions the correct sources on screen.

Select Angled In

Click Apply
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For example, to change the media for the source that is identified as B, select the source 
identified as B, then click the River icon in the Configuration area. Your Preview should 
now look like this: 

Figure 133. Preview with New Media Source

Virtual Sets

In Rich Media Desktop Pro, you can also add pre-built source sets complete with 
graphics to simulate a news-anchor desk. These sets are appropriately called virtual 
sets which can be added to your source list. Virtual sets are predefined sources with 
graphics, available in various configurations. For example, you can select a two-source 
virtual set that displays three layers of decor (overhead lighting, a curved desk and a 
pillared background) with two live sources.

Virtual sets provide you with an easy way to create a professionally looking scene with 
one or more live feed sources superimposed on it. These virtual sets can be used as 
they are, or they can be edited to suit your needs.

Click the B source

Click the River icon

PRO
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To add a virtual set to your shot, click the Add Presets button to the right of the Sources 
list title. In the Template Chooser window, select the Virtual Sets tab, then click the 
virtual set you want to use. Click Apply to display it in the Shot Editor preview area.

Figure 134. Virtual Sets

Select a source by clicking on the name of the source in the list. 

Figure 135. Selecting a Shot Source

Controlling Source Visibility
The condition of the icon to the left of each source name controls its visibility. You can 
hide or display sources in a shot by clicking its icon. When a source is hidden a red X is 
displayed over the icon.

For example, if your shot has a title, you can turn the title off by clicking once on the 
icon to display the red X. All of your title data still stays within the shot, but it is just not 
shown. To turn the title it back on, click the icon again and the red X will disappear. This 

Select the Virtual 
Sets tab

Click Apply

Select a Virtual 
Set

Click a source name to select it
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can be a powerful way to use Rich Media Desktop by pre-loading your shots with titles 
and then turn them on and off during your broadcast.

Note: The first time you select a source, its visibility is turned on (Rich Media Desktop 
assumes if you are clicking on it, you want to display it).
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Shot Editor Preview 
The Preview area displays, in real time, the changes you make to the static video 
sources in your shot. However, temporal features (fade-in, audio playback, etc.) are not 
portrayed in this still shot. You can also click and drag a source displayed in the Preview 
area, to reposition it.

If you add a Virtual Set, the Preview area displays a zoom slider directly below the 
preview window. This enables you to adjust all of the layers in the virtual set, to zoom in 
on the set for a a close up or pull back for a wide-angle view.

Figure 136. Edit Preview window

Zoom slider
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Shot Editor Media Panel 
The Shot Editor Media Panel provides a library of your shots, enabling you to easily 
assign a media to a given source. You can assign three types of media to a source: Live 
Feeds, Media Files, and Title Banners. The Media Panel displays each category 
separately, making it easier to categorize and identify your media.

Figure 137. Media Panel

Live Feed Sources 
Click the Movie Camera button (camera icon) to display, manage, and select your Live 
Feed sources. Live feeds also include the devices built in to your computer: 
microphone, Audio in (PC Audio Card), and any USB . 

To add a live feed to a selected source, follow these steps:

1. Click the movie camera icon in the media panel.

2. Click the Plus (+) icon at the bottom of the media panel and select the system device 
you want to use for input. Rich Media Desktop adds it to the list.

3. Click the configure button (2nd button from right in the toolbar) to configure the 
device as needed.

4. Click the change media button (far left in the toolbar).

5. Click the Plus (+) icon at the bottom of the media panel, and select Show Source 
Settings to view and configure source settings.

6. In the Source Settings panel, select the device to display and change settings as 
needed.

7. Click Apply to save settings and close the Source Settings window.

In Rich Media Desktop Pro, you can add other system devices, including  a Scoreboard, 
and IP cameras.

Live Feeds button

Media Files button

Title Banners button

PRO
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Media File Sources 
Click the Media Files button (document icon) to display, manage, and select your file-
based media sources. Media files are recordings residing as files that can be played in 
QuickTime. This includes: video and audio files, video-only files, audio-only files, and 
raster images (TIFF, JPEG, PNG, etc). Media files are created outside of Rich Media 
Desktop using media editing tools, then are added to the media list for easy access 
during broadcasting.

To add media files that you have created (or acquired) to a selected source, follow these 
steps:

1. Click the Media Files button (document icon) in the media panel.

2. Click the Plus (+) icon at the bottom, and navigate to and select the file you want to 
add. Rich Media Desktop adds this file to the list.

3. Configure it as needed.

Title Banner Sources 
Click the Title Banner button (T icon) to display and select a title banner source. Rich 
Media Desktop provides a comprehensive library of one, two, and three line title 
banners from which you can choose. Title banners are graphic files with text fields that 
display information you provide. You can not add your own banner files.

To add a title banner to a selected source, follow these steps:

1. Click the Title Banner button (T icon) in the media panel toolbar.

2. Click the Plus (+) icon at the bottom of the media panel and select the title banner 
file you want to use to title this shot. Rich Media Desktop adds this title to the list.

3. Configure the title as needed by entering the text strings for each title line using the 
Text Attributes tool (4th button from left in the toolbar).
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Shot Editor Effects 
The Effects Panel enables you to adjust the location of sources and configure opacity, 
matte, aspect ratio, and scaling as needed. To open the Effects Panel, click the 
Configure button (2nd button in the toolbar). 

Clicking the position buttons (arrows) enables you to quickly change the position of 
the media in the preview display. 

Figure 138. Effects Panel

You can also reposition a title using the mouse:

• To Move Media Click and drag using the mouse in the Preview area.

• Resize Respect Aspect Hold the Alt key while moving the mouse in the Preview 
area.

• Resize Media Turn off Respect Aspect Ratio. Hold the Shift-Alt keys while moving 
the mouse in the Preview area.

• Rotate Media Hold the Ctrl key while moving the mouse in the Preview area. Select 
between shots in the Main window 

Opacity
The opacity control is a slider bar on the Effects Panel. Opacity controls how much you 
can see through the media. Technically, transparency means to completely see through 
an object, but Rich Media Desktop provides only a partial transparency, it is called 
opacity (how opaque the object is).

Configure button

Position buttons
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Figure 139. Opacity Control

Matte 
A matte is an image that is used to define the opacity of another piece of media. Rich 
Media Desktop comes with several mattes, which are listed in the Matte drop-down 
menu. Any image in your shot list which has an Alpha Channel will also show up in the 
Matte menu. (See Images/Opacity for more information on Alpha Channel.)

Figure 140. Matte Control

Note: If you want to turn off the media altogether, do not set opacity to zero since 
this still uses CPU cycles. Instead, you should turn off the visibility of the source.

Opacity control

Matte menu
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Aspect Ratio 
The Respect Aspect Ratio is located under the Matte menu on the Effects Panel. When 
checked, the source retains its aspect ratio when its size is changed. Some sources do 
not allow you to set this option.

Figure 141. Aspect Ratio Control

Reposition Buttons
The are three repositioning buttons on the Effects Panel: Reset Position, Scale To Fit, 
and Horizontal Flip. Click the Reset Position button to reset the media to its original 
position, size, and rotation. Click Horizontal Flip to mirror the media along the vertical 
axis. Click Scale to Fit button to scale the media to fit inside the broadcast window.

Figure 142. Reposition Buttons

Aspect Ratio control

Reset Position

Horizontal Flip

Scale To Fit
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Shot Editor Cropping 
The cropping control enables you to cut off unwanted portions of an image. To open 
the cropping control window, click the cropping control button.There are four sliders 
and four text boxes used to control cropping. Select an image, then slide the slider until 
the selected side of the image is cropped as needed. Notice that as the slider is moved, 
the value in the text box changes. This values is the number of pixels that have been 
cropped. You can also enter values directly.

Figure 143. Cropping Control

Cropping control button

Cropping values

Cropping sliders
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Shot Editor Chroma Key
Rich Media Desktop enables you to perform real-time Chroma Key operations on your 
sources during a broadcast. Chroma keying enables you to select a color and replace all 
occurrences of that color in an image with some other image. Click the Chroma Key 
button to open the Chroma Key controls. Click the Use Chroma Key checkbox to enable 
the controls. Use the sliders to set the Key Threshold, Black Clip, and White Clip. Click 
the Defaults button to restore all controls to their default state.

Figure 144. Chroma Key Controls

Working Top Down
The key color is the color of the background you want to drop out of the resulting 
media. The Chroma Key configuration panel is designed to work through the 
configuration as a process, from top to bottom, fine tuning your key as you go. It is 
important to not over-adjust any one control. A good key color is obtained by finding 
the right balance in the controls.

Selecting a Key Color
To get the best key possible, select the key color using the mouse. To do this check the 
Pick key color with mouse checkbox. Use the mouse to click a point on the image in the 
preview area. As you do this watch the preview change in level of transparency, 
displaying the t gray/white checkerboard pattern on the affected regions. Usually, 
clicking near the corners of the media provides the best key, but sometimes clicking 
near the main subject in the image is best.

Key Threshold
Once you have the best key by picking the color, you can adjust the key threshold to 
drop out the background as completely as possible. The Key Threshold parameter 
enables Rich Media Desktop to determine how close the color in the video is to the key 
color. Adjust the key threshold (0 to 100) by using the slider.

Chroma Key button

Slider controls

Default button

Use Chroma Key 
checkbox
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Black Clip
Sometimes, dark areas are keyed out, when they should not be, due to how digital 
cameras function. The Black Clip parameter controls how close the keying will be 
toward black. For example, if the host has black hair, you need to increase this value 
slightly so that the keying effect will not be seen in his hair. Adjust the Black Clip (0 to 
100) by using the slider.

White Clip
Likewise, white areas are also sometimes keyed out when they should not be. The 
White Clip parameter controls how close the keying will be toward white. For example, 
if the host has a white shirt on, you need to increase this value slightly so that the 
keying effect will not be seen in his shirt. Adjust the White Clip (0 to 100) by using the 
slider. 

Getting a Good Key 
Probably the most important part of getting a good key is getting good source 
material. Poor source material will generate poor keys; no algorithm can make up for 
this.

Lighting
Assuming you have a reasonably good camera, the most important part of getting a 
good key is good lighting. Invest in good lights and learn how to set them up properly. 
Here are some basics: 

• The background screen (green or blue) needs to be independently lit from other 
items in the shot.

• Light the background screen evenly, with no shadows. The more evenly lit, the bet-
ter the keying.

• Light people evenly with no shadows. A fill light is very important. An office white 
board may be helpful in accomplishing this.

Good Camera
You should get reasonable quality out of most cameras on the market today. Rich 
Media Desktop has been tested with a low-end DV cameras to verify the quality of its 
Chroma Keying system. However, the better the camera the better the keying. 

If you use a cheap USB Web-cam, it will not give you enough source quality to get a 
reasonable good key. But if you have excellent lighting, a USB camera will work well. 
3CCD is better than 1CCD. If you have the choice, a PAL camera is better than NTSC, due 
to how data is captured internally.
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High Quality Video
If you are keying video from disk and not capturing it live, make sure the High Quality 
Video option is checked in the Advanced Preferences Panel. This forces Rich Media 
Desktop to decode the video from disk in the best quality possible, giving the Chroma 
Key the best data possible for keying. Rich Media Desktop will warn you if High Quality 
Video is turned off when you turn on Chroma Keying.

Figure 145. Chroma Keying
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Shot Editor Motion 
The Motion Panel provides control over how objects (image, movie, title, etc.) are 
added or removed in the Broadcast window. To open the Motion Panel, click the 
Motion Panel button in the Toolbar. Rich Media Desktop only performs motion during a 
Smooth transition. If you are using any other transition, the motion settings are 
ignored.

There are two types of motion. When an object is added to the Live broadcast it is 
called Build-In; When it is removed it is called Build-Out.

Figure 146. Motion Panel

Motion only occurs when an object enters or leave the broadcast window. For example, 
if you have two shots, each with a foreground and the media in the foreground is the 
same, then a Smooth transition will be performed between the foregrounds. However, 
no motion is performed. Or, if a logo is positioned in the top left corner in an existing 
shot, and it is in the bottom right corner in a new shot, when you make the new shot 
Live the logo will smoothly transition from the top left corner to the bottom right 
corner. But the Build-In and Build-Out settings are ignored.

However, if you have two shots with a Foreground, but the media in each is different, 
the Build-Out will be performed for the existing shot, and the Built-In will be performed 
for the new shot.

Direction Menus These provide selections of where the Build-In will come from (top, 
bottom, right, etc.) when it is added, and where the Build-Out will go when it is 
removed.

Fade In / Fade Out Checking these checkboxes causes an object to be added or 
removed gradually. If unchecked, the object will be instantly added or removed, much 
like a cut transition.

Spin In / Spin Out Checking these checkboxes causes an object to be added or 
removed in a spinning fashion.

Scale In / Scale Out Checking these checkboxes causes an object to be added or 
removed in a scaled fashion.

Decelerate In / Accelerate Out Checking these checkboxes causes all of the above 
actions to be performed at a slower or faster rate.

Motion Panel button

Build-In controls

Build-Out controls

Direction menus
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Apply To All Click this button to make the Motion Settings the same for all sources in a 
shot. This is useful if you want to make all of your motion the same for all of the 
elements in the shot.
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Shot Editor Playback 
The Playback Panel enables you to control how movies and music play in Rich Media 
Desktop. To open the Playback Panel, click the Playback Panel button. 

Figure 147. Playback Panel

Check the Live Playback checkbox to cause your changes to be taken live in your 
broadcast. The four control buttons enable you to rewind, play, pause, or fast forward. 
In Point & Out Point sets the start and stop points in the media. 

Select what to do when the media is finished (loop, hold, or remove) from the drop-
down menu. Check the Begin Playing checkbox to cause the media to automatically 
start playing when it becomes live. Check the Remember Position checkbox to cause 
the media to remember its position when it is not live.

The vertical slider set the audio level and the two meters display it in stereo (left and 
right). Click the Master Audio Mute icon to mute the audio of your broadcast. Click it 
again to un-mute it. Click the Headphones icon to mute the local audio feed. Click it 
again to un-mute it. 

The Playback Panel only allows modification of parameters on media for which the 
options are possible. For example, if your media has no audio, then the audio controls 
will not be active. Or, if your media is a still image, you will not be able to set an In point 
or Out point nor play the image.

The Playback Panel setup information is saved separately for each shot, so if a media is 
used in two different shots, the media settings will be different in each shot.

Live Playback 
Live Playback is a part of the Playback settings. By default, changes in the Playback 
Panel are like any other changes in the Shot Editor, they do not take effect until you 
click the Go button. However, there are times when you may want to scrub (slowly 
scroll and view) the video and see the scrubbing in the Live broadcast.

Figure 148. Live Playback Control

Playback Panel button
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Check the Live Playback checkbox to cause changes you make in the Playback Panel to 
become live. This gives you immediate control over the movie or audio in the Live 
broadcast.

Scrubbing 
The Scrubbing slider enables you scrub (scan) back and forth through your media. The 
triangle icon in the scrubbing slider is called the playhead.

Click and drag this triangle (playhead) left and right to view any location in your media. 
The primary use of scrubbing is to set the In Point and Out Point in your media. If Live 
Playback is checked, and the shot you are editing is live, then the scrubbing will also be 
seen in your Live broadcast.

Figure 149. Scrubbing Control

Transport Controls
The Transport controls enable you to Rewind, Play, Pause, and Fast Forward. If Live 
Playback is checked, any changes you make using these controls will be seen in your 
broadcast.

Figure 150. Playing/Transport Control

In and Out Points 
The In Point and Out Point controls are a part of the Playback settings. The In Point is 
the position in the media where playback will start from. For example, if you set the In 
Point of a movie to 2 seconds, when the movie starts to play (or loops back to the start), 
it will start from the 2 second point in the movie. The Out Point is the position in the 
media where playback will end. if you set the Out Point of a movie to 5 minutes, when 
the movie reaches the 5 minute mark, it will stop playing (or loop back to the 
beginning, depending on which When Finished option you have selected).

Note: If you want to pause all movies in your broadcast, you can select Pause All 
Movies from the Media menu. This is particularly useful if you only have just one 
movie and you want to quickly pause it.

Playhead (triangle icon)

Rewind

Play

Pause

Fast Forward
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To set the In Point, move the playhead to a place you want the media to start playing 
and click the first Set button. To set the Out Point, move the playhead to the place you 
want the media to stop playing and click the second Set button. Clicking a Jump button 
moves the playhead to the In Point or Out Point location.

Figure 151. In Point and Out Point Controls

When Finished Control
The When Finished drop-down menu enables you to control what happens when the 
media finishes playing (when it reaches the Out Point).

You have three options: 

• Loop the media will loop back to the In Point.

• Hold The media will simply stop and show the last frame.

• Remove the media is removed from Live Broadcast.

Figure 152. When Finished Control

Begin Playing Control
When checked, the Begin Playing checkbox causes the media to start playing when the 
shot becomes Live. Checked is the default.

Figure 153. Begin Playing Control

Remember Position Control
If the Remember Position checkbox is checked, when a live shot transitions to another 
shot with different media, the removed shot remembers the last position where the 

In point and Out Point times

Set buttons

Jump buttons

Note: For media without video, the Hold and Remove are effectively the same 
option.
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media was played. And so, if the removed shot becomes live again it will start playing 
from that remembered position. Checked is the default.

Figure 154. Remember Position Checkbox

Audio Controls
If a piece of media contains audio, the audio controls become activated. The audio in 
each media is independently controlled. The audio slider bar enables you to control the 
media audio level. Clicking the speaker icon mutes the audio of your media in the Live 
Broadcast. Clicking it again causes it to be heard. The stereo audio meters monitor the 
audio output level. If you want your users to continue hearing the media, but want to 
mute your headphones (or local speakers), click the headphone icon.

Figure 155. Audio Control

Note: 

Audio meters

Audio slider

Speaker icon

Headphone icon
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These topics provide helpful information about how to prepare for creating great 
presentations.
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Introduction
There are a many ways to make a good presentation even better. But this topic will 
focus on three main things to remember about video streaming: 

1. High Quality Audio Input Great looking video with poor audio input will appear 
unprofessional. 

2. Good Lighting Poor lighting can ruin an otherwise excellent presentation. If you are 
doing chroma keying this may become the most important part of your setup. 

3. Broadcast Settings Make sure the broadcast settings are configured correctly for 
your presentation. There are three that are the most important: bandwidth, motion, 
and encoder settings.

When video is saved to disk or sent over the network, it needs to be compressed. The 
compression process is done by encoders (codecs) which are optimized to work with 
clean input data. This means that if the audio or video is muddy to start with, it will be 
muddy after compression. Some codecs may even highlight poor input because the 
algorithm is built to look for differences.

Your goal should be to give the best quality audio and video to the compression 
process as possible. This means making sure what you see in the Live area is the best 
possible quality because Rich Media Desktop takes exactly what you see and sends it to 
the codecs.
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High Quality Audio
Audio has an artistic aspect to it. You can make a great presentation even better by 
remembering to focus on a few details. Here are some suggestions on producing clean 
audio.

1. Use a Good Microphone Though this may sound obvious, a good microphone can 
make a huge difference. Most DV cameras have an audio input for an external 
microphone. Use this, whenever possible, instead of the built-in microphone that 
comes with the camera. Built-in microphones are usually not good quality and will 
pick up hum from the electronics inside the camera. Even when it is not a great 
microphone, an external microphone will almost always sound better.

2. Use a Microphone Splitter If you are doing an interview with one camera, you can 
use two microphones with a splitter ($5 from Radio Shack). This often gives better 
results than one omni-directional microphone at a distance. You can also use a dual 
lapel microphone with a splitter.

3. Position the Microphone Properly Place any microphone as close to the sound 
source as possible, even when using omni-directional microphones, because sound 
volume decreases greatly the farther away the microphone is placed. Stronger 
signals coming into the microphone will result in better quality.

4. Use Lapel Microphones Even inexpensive (less than $20) lapel microphones can 
make a huge difference because it places the microphone much closer to the person 
speaking.

5. Control Environmental Noise If a chair squeaks, use a different one. If you have a 
wood floor and you can hear people shuffling their feet as they talk, put down a rug. 
Do whatever it takes to keep noise at a minimum. Microphones pick up everything.
RMD User Guide | 81707 February, 2012



Making Great Presentations
Good Lighting

206
Good Lighting
Do not underestimate the power of lighting. When an event is broadcast outdoors, a 
great deal of attention goes into lighting. For professionals, lighting is view as an artistic 
task. Many people make their living controlling lighting, so there is a lot to it. Here are a 
few suggestions to help you obtain reasonably good lighting:

1. If you are using only one lighting source, do not shine it directly on your subject. You 
should diffuse the light.

2. Avoid deep shadows. Make sure you fill all areas of your subject with light. 
Sometimes this will require adjusting the light to bounce off a different wall, or by 
using two lights. Placing a light low and another one high is often a good way to 
light evenly.

3. Do not light too evenly. If you completely evenly light a set, you may actually be 
worse off than not lighting the set at all. Take a sample shot and see if it looks natural. 
Good lighting usually has a little more light coming from above than any other 
direction. You should very rarely light just from below a subject.

4. Beware of having too much light on your subject. If your subjects are people, and 
you must use a lot of light, you will need to use make-up to compensate for the 
overly bright lighting. This is not necessarily a bad thing, but you must choose how 
much effort you want to go through to make a good presentation. If your lighting 
balance is excellently balanced, you will not need to use make-up on your subjects. 
The key in adjusting the lighting is to look at your subject and make sure they do not 
look washed out

5. Watch professional broadcasts and learn from them. As you watch notice how are 
they lighting instead of watching the program. Notice how they employ all of the 
suggestions listed above.

Though these rules may sound vague, they really are not. The important thing to 
remember is that one or two properly placed lights will make a huge difference in the 
quality of your presentation. 

Triangular Lighting
One advanced and very effective approach to good lighting is known as Triangular 
Lighting (or Three Light Setup). Although this may sound complicated, it is actually 
quite simple. It involves setting up three lights (sometimes using natural light as one of 
the light sources), in a configuration that achieves a good balance. Here are the main 
elements of Triangular Lighting:

1. Main Light (Key Light) This is the strongest of your lights, and does most of the 
work. This light normally comes from one side of the camera (the left, for example), 
and is a slightly raised. However, using just the main light will result in shadowing.

2. Fill Light This is a soft light placed directly in front of subject. It removes shadows 
and fills in the image. It is usually direct, and usually comes from the same direction 
as the camera (or just to the side and behind it). It would be, for example, placed on 
the same level as the head of a person you are lighting. If you use only a fill light, your 
subject will be too dark. The only purpose of a fill light is to add to the main light by 
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filling in shadows. If your Key light comes from the left of your camera, your fill light 
should come from the right, and vice versa.

3. Back Light (Rim Light) This light is directed from behind the subject and above it. 
This is the hardest light to explain, but the best way is to describe it as an accent of 
your subject. If you look at a typical high school yearbook picture, you will notice 
that the top-left (or top-right) part of this head shots has a highlight of light in it. This 
light is the Back Light. It is also called a Rim Light because it makes a slight rim 
around the edge of the head of your subject. This light normally comes from behind 
the subject, but often from above, and it is focused. Make sure it is not directed at the 
camera.

Most serious lighting starts with these three basic lights. There are also some great 
Websites that describe these techniques in great detail.
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Broadcast Settings 
Once you have good video and audio coming into Rich Media Desktop, the final item of 
importance is make sure the Broadcast Settings are configured correctly for your 
presentation. Though there are many broadcast parameters to modify, there are three 
that are the most important: bandwidth, motion, and encoder settings.

Bandwidth
The first item of importance is knowing how much bandwidth is available. Bandwidth is 
how much data you can broadcast from your computer. This depends on the speed of 
your network connection and the type of connection your viewers are using. More 
specifically, it is the minimum speed between you and all of your viewers. For example, 
if you have one viewer who is using a dial-up modem, for that viewer to see good 
quality you must broadcast at Modem speed.

Thus, you must know who your viewers are and what kind of connection they have. 
This may be difficult to know because you must determine if their connection is cable 
modem or DSL and whether or not they reside on your local network.

In some situations, you are broadcasting for just your local network (in an office 
building, for example). In this case you should discuss your plans with your network 
administrator and verify that you will not disrupt the network with your broadcasts. Ask 
them what your upper limit bandwidth should be. Your available bandwidth will be the 
minimum of what you can upload, combined with what your viewers can download.

Motion
Once you know your bandwidth, you need to decide whether or not your video will 
contain a lot of motion. Motion is how much things move around in your video 
presentations. An interview is considered low motion. A sports even, however, would 
probably be high motion. Rich Media Desktop comes configured with defaults to help 
ease your configuration task. Choose a default configuration that meets your motion 
(and bandwidth) constraints.

If your viewers have older versions of QuickTime (version 5 for example), you may want 
to use a different Encoder than the default. Using the Sorenson 3 Codec for version 5 of 
QuickTime may be the most effective solution.

Encoder Settings
The parameters of the encoders are be quite technical and can be overwhelming. It is 
beyond the scope of this document to describe the delicate balance required in setting 
them. There are professionals who fine-tune encoders to do exactly what is required. 
The Rich Media Desktop default setting are generally optimal for the various network 
environments. (See Setting Encoder Presets for information on changing the encoder 
settings.)
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Desktop.
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FireWire
FireWire is a hardware protocol that you may use to connect devices (cameras, hard 
drives, etc.) to your computer. But it is important to understand that saturating your 
FireWire bus (using up all available bandwidth) will lead to problems in Rich Media 
Desktop. As a result the audio and video will appear choppy.

Bandwidth Limits
There is an absolute limit to the bandwidth available to your FireWire devices (400 or 
800 megabits per second). If the sum of your devices goes over the limit, you saturate 
(use up) all the available bandwidth. For example, if you have a camera attached to the 
FireWire bus and you saturate the bus, you will see dropped frames (choppy video).

If you use a FireWire hub and plug several devices into the hub, you share the maximum 
bandwidth on the FireWire bus. Adding a hub does not add bandwidth to the bus, just 
more places to plug devices in. Likewise, you may have several FireWire ports on your 
computer, but they are often all connected to the same bus. You have to add a separate 
FireWire card to increase the bandwidth.

Bandwidth Use
If you have a hard disk connected to a FireWire hub and also have a camera connected 
to the same hub, it may appear to work but this is not a good indication of whether the 
bus will become saturated. For example, when new email arrives and your email 
program accesses a file on your FireWire drive, it can cause FireWire saturation.

So be mindful of this limitation when connecting hardware to your computer. Just 
because your setup works when you first put it together does not mean it will always 
work. Experiment with your setup and make sure that you have enough FireWire 
bandwidth to share all of your devices without experiencing choppy video.

Normally, a camera requires around 25 Mbps (megabits/second) to deliver audio and 
video to Rich Media Desktop. However, some cameras may require 100 Mbps or more.
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Universal Serial Bus (USB)
Many cameras use USB instead of FireWire to connect to the computer, but the same 
problems for FireWire apply to USB connections. So, keep as few devices on the bus as 
possible to prevent saturation. Keep in mind that even if you have multiple USB sockets 
they are often attached to the same USB bus. The USB devices dialog can be used to 
identify buses with available ports. Standard USB supports up to 12 Mbps and High-
Speed USB supports up to 480 Mbps.
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High Definition (HDV) 
Always uses the best quality camera you can get. Even if your viewers are going to see 
only 176×144 (G3 Mobile) an HDV camera is going to give you much better quality than 
a USB camera.

Although you can achieve extremely high quality video using HDV, there are some 
limitations in using it. Most of these limitations are due to resource consumption. Even 
if you have multiple busses, to use more than one HDV camera with Rich Media 
Desktop you will need a high-end (fast and powerful) computer. HDV images are so 
large they stress all components involved in your production (memory, video memory, 
video fill rate, bandwidth, etc.).

HDV Cameras in DV Mode.
If you only have HDV cameras, and you need to use several cameras, put your 
secondary cameras in DV mode. This will save bandwidth. When you switch your HDV 
camera to DV mode, your camera acts like a DV camera. Although you do not get HDV 
quality, you get much higher quality than your average DV camera because most HDV 
cameras have very high quality CCD elements in them.
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DV Cameras 

One Camera Per Bus
Generally, you should not attach more than one camera to a FireWire or USB bus, even 
when using high-speed busses. The main reason for this is that most cameras will 
conflict with other devices on the same bus. For example, on FireWire bus each camera 
is expected to negotiate the channel it will use to transmit. Some cameras do not 
negotiate at all or ignore the results of the negotiation and a conflict will result. This 
causes problems in Rich Media Desktop because the incoming signal is from two 
cameras.

Also, since some cameras randomly pick a transmission channel, there is always a 
chance that two will choose the same channel.
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Sleep Mode
When a computer puts a monitor in sleep mode (screen saver mode) it also turns off the 
video card. Since Rich Media Desktop uses your video card for broadcasting, your 
broadcast will be interrupted when the computer enters the sleep mode. But, Rich 
Media Desktop automatically tells the operating system not put your monitor in sleep 
mode so that this will not happen accidentally if your screen saver is on. However, if you 
force your monitor into sleep mode, your broadcast will stop.
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S-Video & 2nd Display 
You can select an external display for the output of Rich Media Desktop. For example, if 
you have a projector connected to your computer using S-Video, select that projector 
from the Broadcast menu to display the output of Rich Media Desktop on it. If you have 
a dual-head graphics card, you can select a second monitor to display Rich Media 
Desktop Output.

Note: You have two graphics cards, Rich Media Desktop may not be able to display to 
any devices (monitors) on the second graphics card.
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Configure Devices
Some devices (cameras, etc) can be configured. Choose the device you want to 
configure from Configure Devices in the Media menu.

Note: The configuration user interface is provided by the device maker. It is beyond 
the scope of this document to describe all of the features available for all devices. See 
the documentation provided with your device on how to configure it.
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This topic guides you through installing (or upgrading) and activating Rich Media 
Desktop.
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Installing
To install Rich Media Desktop, follow these steps:

1. First download the installer from the VBrick Website at:
http://www.vbrick.com/products/capture/rich-media-desktop.asp.

2. Run the installer (.exe) program and follow the instructions provided.

3. If you have the same version of Rich Media Desktop already installed on your 
computer, the installer will ask if you want to repair or remove the existing version. 
Select Repair if you are reinstalling the same version of Rich Media Desktop in an 
attempt to correct a problem. Select Remove if you want to uninstall the existing 
version of Rich Media Desktop. 

4. If you have an older version of Rich Media Desktop already installed on your 
computer, the installer will upgrade to the newer version.

5. Agree to the license agreement and follow the instructions displayed by the installer 
program.
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Activating
When you purchased Rich Media Desktop a serial number was provided. This serial 
number must be registered in the Rich Media Desktop program to unlock the features 
of Rich Media Desktop. To register Rich Media Desktop follow these steps:

1. Run the Rich Media Desktop program.

2. Select Preferences from the File menu, or press the Ctrl+Comma (,) keys, then click 
Register.

3. Click the Add (+) button, enter your serial number in the dialog window, and click 
OK.

4. Your serial number is displayed.

Figure 156. Registering

5. Close the Preferences window.

Your Rich Media Desktop program should now be fully activated.
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Uninstalling
To uninstall Rich Media Desktop, follow these steps:

1. Run the Rich Media Desktop installer (.exe) program. 

2. The installer will ask if you want to repair or remove the existing version. Select 
Remove to uninstall the existing version of Rich Media Desktop.
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Overview
Portions of this software may utilize the following copyrighted material, the use of 
which is hereby acknowledged:

– Darwin streaming server

– FFmpeg Project

– Darwin streaming server

APPLE PUBLIC SOURCE LICENSE Version 2.0 - August 6, 2003 Please read this License 
carefully before downloading this software.

By downloading or using this software, you are agreeing to be bound by the terms of 
this License. If you do not or cannot agree to the terms of this License, please do not 
download or use the software.

1. General; Definitions. This License applies to any program or other work which Apple 
Computer, Inc. ("Apple") makes publicly available and which contains a notice placed 
by Apple identifying such program or work as "Original Code" and stating that it is 
subject to the terms of this Apple Public Source License version 2.0 ("License"). As used 
in this License: 1.1 "Applicable Patent Rights" mean: (a) in the case where Apple is the 
grantor of rights, (i) claims of patents that are now or hereafter acquired, owned by or 
assigned to Apple and (ii) that cover subject matter contained in the Original Code, but 
only to the extent necessary to use, reproduce and/or distribute the Original Code 
without infringement; and (b) in the case where You are the grantor of rights, (i) claims 
of patents that are now or hereafter acquired, owned by or assigned to You and (ii) that 
cover subject matter in Your Modifications, taken alone or in combination with Original 
Code.

1.2 "Contributor" means any person or entity that creates or contributes to the creation 
of Modifications.

1.3 "Covered Code" means the Original Code, Modifications, the combination of 
Original Code and any Modifications, and/or any respective portions thereof.

1.4 "Externally Deploy" means: (a) to sublicense, distribute or otherwise make Covered 
Code available, directly or indirectly, to anyone other than You; and/or (b) to use 
Covered Code, alone or as part of a Larger Work, in any way to provide a service, 
including but not limited to delivery of content, through electronic communication 
with a client other than You.
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1.5 "Larger Work" means a work which combines Covered Code or portions thereof 
with code not governed by the terms of this License.

1.6 "Modifications" mean any addition to, deletion from, and/or change to, the 
substance and/or structure of the Original Code, any previous Modifications, the 
combination of Original Code and any previous Modifications, and/or any respective 
portions thereof. When code is released as a series of files, a Modification is: (a) any 
addition to or deletion from the contents of a file containing Covered Code; and/or (b) 
any new file or other representation of computer program statements that contains 
any part of Covered Code.

1.7 "Original Code" means (a) the Source Code of a program or other work as originally 
made available by Apple under this License, including the Source Code of any updates 
or upgrades to such programs or works made available by Apple under this License, 
and that has been expressly identified by Apple as such in the header file(s) of such 
work; and (b) the object code compiled from such Source Code and originally made 
available by Apple under this License.

1.8 "Source Code" means the human readable form of a program or other work that is 
suitable for making modifications to it, including all modules it contains, plus any 
associated interface definition files, scripts used to control compilation and installation 
of an executable (object code).

1.9 "You" or "Your" means an individual or a legal entity exercising rights under this 
License. For legal entities, "You" or "Your" includes any entity which controls, is 
controlled by, or is under common control with, You, where "control" means (a) the 
power, direct or indirect, to cause the direction or management of such entity, whether 
by contract or otherwise, or (b) ownership of fifty percent (50%) or more of the 
outstanding shares or beneficial ownership of such entity.

2. Permitted Uses; Conditions & Restrictions. Subject to the terms and conditions of this 
License, Apple hereby grants You, effective on the date You accept this License and 
download the Original Code, a world-wide, royalty-free, non-exclusive license, to the 
extent of Apple's Applicable Patent Rights and copyrights covering the Original Code, 
to do the following: 2.1 Unmodified Code. You may use, reproduce, display, perform, 
internally distribute within Your organization, and Externally Deploy verbatim, 
unmodified copies of the Original Code, for commercial or non-commercial purposes, 
provided that in each instance: (a) You must retain and reproduce in all copies of 
Original Code the copyright and other proprietary notices and disclaimers of Apple as 
they appear in the Original Code, and keep intact all notices in the Original Code that 
refer to this License; and (b) You must include a copy of this License with every copy of 
Source Code of Covered Code and documentation You distribute or Externally Deploy, 
and You may not offer or impose any terms on such Source Code that alter or restrict 
this License or the recipients' rights hereunder, except as permitted under Section 6.

2.2 Modified Code. You may modify Covered Code and use, reproduce, display, 
perform, internally distribute within Your organization, and Externally Deploy Your 
Modifications and Covered Code, for commercial or non-commercial purposes, 
provided that in each instance You also meet all of these conditions: (a) You must satisfy 
all the conditions of Section 2.1 with respect to the Source Code of the Covered Code; 
(b) You must duplicate, to the extent it does not already exist, the notice in Exhibit A in 
each file of the Source Code of all Your Modifications, and cause the modified files to 
February, 2012 RMD User Guide | 81707



Acknowledgements
Acknowledgements

223
carry prominent notices stating that You changed the files and the date of any change; 
and (c) If You Externally Deploy Your Modifications, You must make Source Code of all 
Your Externally Deployed Modifications either available to those to whom You have 
Externally Deployed Your Modifications, or publicly available. Source Code of Your 
Externally Deployed Modifications must be released under the terms set forth in this 
License, including the license grants set forth in Section 3 below, for as long as you 
Externally Deploy the Covered Code or twelve (12) months from the date of initial 
External Deployment, whichever is longer. You should preferably distribute the Source 
Code of Your Externally Deployed Modifications electronically (e.g. download from a 
Web site).

2.3 Distribution of Executable Versions. In addition, if You Externally Deploy Covered 
Code (Original Code and/or Modifications) in object code, executable form only, You 
must include a prominent notice, in the code itself as well as in related documentation, 
stating that Source Code of the Covered Code is available under the terms of this 
License with information on how and where to obtain such Source Code.

2.4 Third Party Rights. You expressly acknowledge and agree that although Apple and 
each Contributor grants the licenses to their respective portions of the Covered Code 
set forth herein, no assurances are provided by Apple or any Contributor that the 
Covered Code does not infringe the patent or other intellectual property rights of any 
other entity. Apple and each Contributor disclaim any liability to You for claims brought 
by any other entity based on infringement of intellectual property rights or otherwise. 
As a condition to exercising the rights and licenses granted hereunder, You hereby 
assume sole responsibility to secure any other intellectual property rights needed, if 
any. For example, if a third party patent license is required to allow You to distribute the 
Covered Code, it is Your responsibility to acquire that license before distributing the 
Covered Code.

3. Your Grants. In consideration of, and as a condition to, the licenses granted to You 
under this License, You hereby grant to any person or entity receiving or distributing 
Covered Code under this License a non-exclusive, royalty-free, perpetual, irrevocable 
license, under Your Applicable Patent Rights and other intellectual property rights 
(other than patent) owned or controlled by You, to use, reproduce, display, perform, 
modify, sublicense, distribute and Externally Deploy Your Modifications of the same 
scope and extent as Apple's licenses under Sections 2.1 and 2.2 above.

4. Larger Works. You may create a Larger Work by combining Covered Code with other 
code not governed by the terms of this License and distribute the Larger Work as a 
single product. In each such instance, You must make sure the requirements of this 
License are fulfilled for the Covered Code or any portion thereof.

5. Limitations on Patent License. Except as expressly stated in Section 2, no other patent 
rights, express or implied, are granted by Apple herein. Modifications and/or Larger 
Works may require additional patent licenses from Apple which Apple may grant in its 
sole discretion.

6. Additional Terms. You may choose to offer, and to charge a fee for, warranty, support, 
indemnity or liability obligations and/or other rights consistent with the scope of the 
license granted herein ("Additional Terms") to one or more recipients of Covered Code.

However, You may do so only on Your own behalf and as Your sole responsibility, and 
not on behalf of Apple or any Contributor. You must obtain the recipient's agreement 
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that any such Additional Terms are offered by You alone, and You hereby agree to 
indemnify, defend and hold Apple and every Contributor harmless for any liability 
incurred by or claims asserted against Apple or such Contributor by reason of any such 
Additional Terms.

7. Versions of the License. Apple may publish revised and/or new versions of this 
License from time to time. Each version will be given a distinguishing version number. 
Once Original Code has been published under a particular version of this License, You 
may continue to use it under the terms of that version. You may also choose to use such 
Original Code under the terms of any subsequent version of this License published by 
Apple. No one other than Apple has the right to modify the terms applicable to 
Covered Code created under this License.

8. NO WARRANTY OR SUPPORT. The Covered Code may contain in whole or in part pre-
release, untested, or not fully tested works. The Covered Code may contain errors that 
could cause failures or loss of data, and may be incomplete or contain inaccuracies. You 
expressly acknowledge and agree that use of the Covered Code, or any portion thereof, 
is at Your sole and entire risk. THE COVERED CODE IS PROVIDED "AS IS" AND WITHOUT 
WARRANTY, UPGRADES OR SUPPORT OF ANY KIND AND APPLE AND APPLE'S 
LICENSOR(S) (COLLECTIVELY REFERRED TO AS "APPLE" FOR THE PURPOSES OF 
SECTIONS 8 AND 9) AND ALL CONTRIBUTORS EXPRESSLY DISCLAIM ALL WARRANTIES 
AND/OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES AND/OR CONDITIONS OF MERCHANTABILITY, OF SATISFACTORY 
QUALITY, OF FITNESS FOR A PARTICULAR PURPOSE, OF ACCURACY, OF QUIET 
ENJOYMENT, AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. APPLE AND EACH 
CONTRIBUTOR DOES NOT WARRANT AGAINST INTERFERENCE WITH YOUR ENJOYMENT 
OF THE COVERED CODE, THAT THE FUNCTIONS CONTAINED IN THE COVERED CODE 
WILL MEET YOUR REQUIREMENTS, THAT THE OPERATION OF THE COVERED CODE WILL 
BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE COVERED CODE WILL 
BE CORRECTED. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY APPLE, AN 
APPLE AUTHORIZED REPRESENTATIVE OR ANY CONTRIBUTOR SHALL CREATE A 
WARRANTY.

You acknowledge that the Covered Code is not intended for use in the operation of 
nuclear facilities, aircraft navigation, communication systems, or air traffic control 
machines in which case the failure of the Covered Code could lead to death, personal 
injury, or severe physical or environmental damage.

9. LIMITATION OF LIABILITY. TO THE EXTENT NOT PROHIBITED BY LAW, IN NO EVENT 
SHALL APPLE OR ANY CONTRIBUTOR BE LIABLE FOR ANY INCIDENTAL, SPECIAL, 
INDIRECT OR CONSEQUENTIAL DAMAGES ARISING OUT OF OR RELATING TO THIS 
LICENSE OR YOUR USE OR INABILITY TO USE THE COVERED CODE, OR ANY PORTION 
THEREOF, WHETHER UNDER A THEORY OF CONTRACT, WARRANTY, TORT (INCLUDING 
NEGLIGENCE), PRODUCTS LIABILITY OR OTHERWISE, EVEN IF APPLE OR SUCH 
CONTRIBUTOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES AND 
NOTWITHSTANDING THE FAILURE OF ESSENTIAL PURPOSE OF ANY REMEDY. SOME 
JURISDICTIONS DO NOT ALLOW THE LIMITATION OF LIABILITY OF INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, SO THIS LIMITATION MAY NOT APPLY TO YOU. In no event 
shall Apple's total liability to You for all damages (other than as may be required by 
applicable law) under this License exceed the amount of fifty dollars ($50.00).
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10. Trademarks. This License does not grant any rights to use the trademarks or trade 
names "Apple", "Apple Computer", "Mac", "Mac OS", "QuickTime", "QuickTime streaming 
server" or any other trademarks, service marks, logos or trade names belonging to 
Apple (collectively "Apple Marks") or to any trademark, service mark, logo or trade 
name belonging to any Contributor. You agree not to use any Apple Marks in or as part 
of the name of products derived from the Original Code or to endorse or promote 
products derived from the Original Code other than as expressly permitted by and in 
strict compliance at all times with Apple's third party trademark usage guidelines 
which are posted at http://www.apple.com/legal/guidelinesfor3rdparties.html.

11. Ownership. Subject to the licenses granted under this License, each Contributor 
retains all rights, title and interest in and to any Modifications made by such 
Contributor. Apple retains all rights, title and interest in and to the Original Code and 
any Modifications made by or on behalf of Apple ("Apple Modifications"), and such 
Apple Modifications will not be automatically subject to this License. Apple may, at its 
sole discretion, choose to license such Apple Modifications under this License, or on 
different terms from those contained in this License or may choose not to license them 
at all.

12. Termination.

12.1 Termination. This License and the rights granted hereunder will terminate: (a) 
automatically without notice from Apple if You fail to comply with any term(s) of this 
License and fail to cure such breach within 30 days of becoming aware of such breach; 
(b) immediately in the event of the circumstances described in Section 13.5(b); or (c) 
automatically without notice from Apple if You, at any time during the term of this 
License, commence an action for patent infringement against Apple; provided that 
Apple did not first commence an action for patent infringement against You in that 
instance.

12.2 Effect of Termination. Upon termination, You agree to immediately stop any 
further use, reproduction, modification, sublicensing and distribution of the Covered 
Code. All sublicenses to the Covered Code which have been properly granted prior to 
termination shall survive any termination of this License. Provisions which, by their 
nature, should remain in effect beyond the termination of this License shall survive, 
including but not limited to Sections 3, 5, 8, 9, 10, 11, 12.2 and 13. No party will be liable 
to any other for compensation, indemnity or damages of any sort solely as a result of 
terminating this License in accordance with its terms, and termination of this License 
will be without prejudice to any other right or remedy of any party.

13. Miscellaneous.

13.1 Government End Users. The Covered Code is a "commercial item" as defined in FAR 
2.101. Government software and technical data rights in the Covered Code include only 
those rights customarily provided to the public as defined in this License. This 
customary commercial license in technical data and software is provided in accordance 
with FAR 12.211 (Technical Data) and 12.212 (Computer Software) and, for Department 
of Defense purchases, DFAR 252.227-7015 (Technical Data -- Commercial Items) and 
227.7202-3 (Rights in Commercial Computer Software or Computer Software 
Documentation). Accordingly, all U.S. Government End Users acquire Covered Code 
with only those rights set forth herein.
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13.2 Relationship of Parties. This License will not be construed as creating an agency, 
partnership, joint venture or any other form of legal association between or among 
You, Apple or any Contributor, and You will not represent to the contrary, whether 
expressly, by implication, appearance or otherwise.

13.3 Independent Development. Nothing in this License will impair Apple's right to 
acquire, license, develop, have others develop for it, market and/or distribute 
technology or products that perform the same or similar functions as, or otherwise 
compete with, Modifications, Larger Works, technology or products that You may 
develop, produce, market or distribute.

13.4 Waiver; Construction. Failure by Apple or any Contributor to enforce any provision 
of this License will not be deemed a waiver of future enforcement of that or any other 
provision. Any law or regulation which provides that the language of a contract shall be 
construed against the drafter will not apply to this License.

13.5 Severability. (a) If for any reason a court of competent jurisdiction finds any 
provision of this License, or portion thereof, to be unenforceable, that provision of the 
License will be enforced to the maximum extent permissible so as to effect the 
economic benefits and intent of the parties, and the remainder of this License will 
continue in full force and effect. (b) Notwithstanding the foregoing, if applicable law 
prohibits or restricts You from fully and/or specifically complying with Sections 2 and/
or 3 or prevents the enforceability of either of those Sections, this License will 
immediately terminate and You must immediately discontinue any use of the Covered 
Code and destroy all copies of it that are in your possession or control.

13.6 Dispute Resolution. Any litigation or other dispute resolution between You and 
Apple relating to this License shall take place in the Northern District of California, and 
You and Apple hereby consent to the personal jurisdiction of, and venue in, the state 
and federal courts within that District with respect to this License. The application of 
the United Nations Convention on Contracts for the International Sale of Goods is 
expressly excluded.

13.7 Entire Agreement; Governing Law. This License constitutes the entire agreement 
between the parties with respect to the subject matter hereof. This License shall be 
governed by the laws of the United States and the State of California, except that body 
of California law concerning conflicts of law.

Where You are located in the province of Quebec, Canada, the following clause applies: 
The parties hereby confirm that they have requested that this License and all related 
documents be drafted in English. Les parties ont exige que le present contrat et tous les 
documents connexes soient rediges en anglais.

EXHIBIT A.

"Portions Copyright (c) 1999-2003 Apple Computer, Inc. All Rights Reserved.

This file contains Original Code and/or Modifications of Original Code as defined in and 
that are subject to the Apple Public Source License Version 2.0 (the 'License'). You may 
not use this file except in compliance with the License. Please obtain a copy of the 
License at http://www.opensource.apple.com/apsl/ and read it before using this. The 
Original Code and all software distributed under the License are distributed on an 'AS 
IS' basis, WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, AND APPLE 
HEREBY DISCLAIMS ALL SUCH WARRANTIES, INCLUDING WITHOUT LIMITATION, ANY 
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WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, QUIET 
ENJOYMENT OR NON-INFRINGEMENT.

Please see the License for the specific language governing rights and limitations under 
the License." 

FFmpeg Project
GNU LESSER GENERAL PUBLIC LICENSE Version 2.1, February 1999 Copyright (C) 1991, 
1999 Free Software Foundation, Inc.

51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA Everyone is permitted to 
copy and distribute verbatim copies of this license document, but changing it is not 
allowed.

[This is the first released version of the Lesser GPL. It also counts as the successor of the 
GNU Library Public License, version 2, hence the version number 2.1.] 

Preamble The licenses for most software are designed to take away your freedom to 
share and change it. By contrast, the GNU General Public Licenses are intended to 
guarantee your freedom to share and change free software--to make sure the software 
is free for all its users.

This license, the Lesser General Public License, applies to some specially designated 
software packages--typically libraries--of the Free Software Foundation and other 
authors who decide to use it. You can use it too, but we suggest you first think carefully 
about whether this license or the ordinary General Public License is the better strategy 
to use in any particular case, based on the explanations below.

When we speak of free software, we are referring to freedom of use, not price. Our 
General Public Licenses are designed to make sure that you have the freedom to 
distribute copies of free software (and charge for this service if you want); that you 
receive source code or can get it if you want it; that you can change the software and 
use pieces of it in new free programs; and that you are informed that you can do these 
things.

To protect your rights, we need to make restrictions that forbid distributors to deny you 
these rights or to ask you to surrender these rights. These restrictions translate to 
certain responsibilities for you if you distribute copies of the library or if you modify it.

For example, if you distribute copies of the library, whether gratis or for a fee, you must 
give the recipients all the rights that we gave you. You must make sure that they, too, 
receive or can get the source code. If you link other code with the library, you must 
provide complete object files to the recipients, so that they can relink them with the 
library after making changes to the library and recompiling it. And you must show 
them these terms so they know their rights.

We protect your rights with a two-step method: (1) we copyright the library, and (2) we 
offer you this license, which gives you legal permission to copy, distribute and/or 
modify the library.

To protect each distributor, we want to make it very clear that there is no warranty for 
the free library. Also, if the library is modified by someone else and passed on, the 
recipients should know that what they have is not the original version, so that the 
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original author's reputation will not be affected by problems that might be introduced 
by others.

Finally, software patents pose a constant threat to the existence of any free program. 
We want to make sure that a company cannot effectively restrict the users of a free 
program by obtaining a restrictive license from a patent holder. Therefore, we insist 
that any patent license obtained for a version of the library must be consistent with the 
full freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the ordinary GNU General 
Public License. This license, the GNU Lesser General Public License, applies to certain 
designated libraries, and is quite different from the ordinary General Public License. We 
use this license for certain libraries in order to permit linking those libraries into non-
free programs.

When a program is linked with a library, whether statically or using a shared library, the 
combination of the two is legally speaking a combined work, a derivative of the original 
library. The ordinary General Public License therefore permits such linking only if the 
entire combination fits its criteria of freedom. The Lesser General Public License permits 
more lax criteria for linking other code with the library.

We call this license the "Lesser" General Public License because it does Less to protect 
the user's freedom than the ordinary General Public License. It also provides other free 
software developers Less of an advantage over competing non-free programs. These 
disadvantages are the reason we use the ordinary General Public License for many 
libraries. However, the Lesser license provides advantages in certain special 
circumstances.

For example, on rare occasions, there may be a special need to encourage the widest 
possible use of a certain library, so that it becomes a de-facto standard. To achieve this, 
non-free programs must be allowed to use the library. A more frequent case is that a 
free library does the same job as widely used non-free libraries. In this case, there is 
little to gain by limiting the free library to free software only, so we use the Lesser 
General Public License.

In other cases, permission to use a particular library in non-free programs enables a 
greater number of people to use a large body of free software. For example, permission 
to use the GNU C Library in non-free programs enables many more people to use the 
whole GNU operating system, as well as its variant, the GNU/Linux operating system.

Although the Lesser General Public License is Less protective of the users' freedom, it 
does ensure that the user of a program that is linked with the Library has the freedom 
and the wherewithal to run that program using a modified version of the Library.

The precise terms and conditions for copying, distribution and modification follow. Pay 
close attention to the difference between a "work based on the library" and a "work 
that uses the library". The former contains code derived from the library, whereas the 
latter must be combined with the library in order to run.

GNU LESSER GENERAL PUBLIC LICENSE TERMS AND CONDITIONS FOR COPYING, 
DISTRIBUTION AND MODIFICATION This License Agreement applies to any software 
library or other program which contains a notice placed by the copyright holder or 
other authorized party saying it may be distributed under the terms of this Lesser 
General Public License (also called "this License").
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Each licensee is addressed as "you".

A "library" means a collection of software functions and/or data prepared so as to be 
conveniently linked with application programs (which use some of those functions and 
data) to form executables.

The "Library", below, refers to any such software library or work which has been 
distributed under these terms. A "work based on the Library" means either the Library 
or any derivative work under copyright law: that is to say, a work containing the Library 
or a portion of it, either verbatim or with modifications and/or translated 
straightforwardly into another language. (Hereinafter, translation is included without 
limitation in the term "modification".) "Source code" for a work means the preferred 
form of the work for making modifications to it. For a library, complete source code 
means all the source code for all modules it contains, plus any associated interface 
definition files, plus the scripts used to control compilation and installation of the 
library.

Activities other than copying, distribution and modification are not covered by this 
License; they are outside its scope. The act of running a program using the Library is not 
restricted, and output from such a program is covered only if its contents constitute a 
work based on the Library (independent of the use of the Library in a tool for writing it). 
Whether that is true depends on what the Library does and what the program that uses 
the Library does.

1. You may copy and distribute verbatim copies of the Library's complete source code 
as you receive it, in any medium, provided that you conspicuously and appropriately 
publish on each copy an appropriate copyright notice and disclaimer of warranty; keep 
intact all the notices that refer to this License and to the absence of any warranty; and 
distribute a copy of this License along with the Library.

You may charge a fee for the physical act of transferring a copy, and you may at your 
option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Library or any portion of it, thus forming a 
work based on the Library, and copy and distribute such modifications or work under 
the terms of Section 1 above, provided that you also meet all of these conditions: a) The 
modified work must itself be a software library.

b) You must cause the files modified to carry prominent notices stating that you 
changed the files and the date of any change.

c) You must cause the whole of the work to be licensed at no charge to all third parties 
under the terms of this License.

d) If a facility in the modified Library refers to a function or a table of data to be supplied 
by an application program that uses the facility, other than as an argument passed 
when the facility is invoked, then you must make a good faith effort to ensure that, in 
the event an application does not supply such function or table, the facility still 
operates, and performs whatever part of its purpose remains meaningful.

(For example, a function in a library to compute square roots has a purpose that is 
entirely well-defined independent of the application. Therefore, Subsection 2d requires 
that any application-supplied function or table used by this function must be optional: 
if the application does not supply it, the square root function must still compute square 
roots.) These requirements apply to the modified work as a whole. If identifiable 
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sections of that work are not derived from the Library, and can be reasonably 
considered independent and separate works in themselves, then this License, and its 
terms, do not apply to those sections when you distribute them as separate works. But 
when you distribute the same sections as part of a whole which is a work based on the 
Library, the distribution of the whole must be on the terms of this License, whose 
permissions for other licensees extend to the entire whole, and thus to each and every 
part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work 
written entirely by you; rather, the intent is to exercise the right to control the 
distribution of derivative or collective works based on the Library.

In addition, mere aggregation of another work not based on the Library with the 
Library (or with a work based on the Library) on a volume of a storage or distribution 
medium does not bring the other work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public License instead 
of this License to a given copy of the Library. To do this, you must alter all the notices 
that refer to this License, so that they refer to the ordinary GNU General Public License, 
version 2, instead of to this License. (If a newer version than version 2 of the ordinary 
GNU General Public License has appeared, then you can specify that version instead if 
you want.) Do not make any other change in these notices.

Once this change is made in a given copy, it is irreversible for that copy, so the ordinary 
GNU General Public License applies to all subsequent copies and derivative works 
made from that copy.

This option is useful when you want to copy part of the code of the Library into a 
program that is not a library.

4. You may copy and distribute the Library (or a portion or derivative of it, under 
Section 2) in object code or executable form under the terms of Sections 1 and 2 above 
provided that you accompany it with the complete corresponding machine-readable 
source code, which must be distributed under the terms of Sections 1 and 2 above on a 
medium customarily used for software interchange.

If distribution of object code is made by offering access to copy from a designated 
place, then offering equivalent access to copy the source code from the same place 
satisfies the requirement to distribute the source code, even though third parties are 
not compelled to copy the source along with the object code.

5. A program that contains no derivative of any portion of the Library, but is designed 
to work with the Library by being compiled or linked with it, is called a "work that uses 
the Library". Such a work, in isolation, is not a derivative work of the Library, and 
therefore falls outside the scope of this License.

However, linking a "work that uses the Library" with the Library creates an executable 
that is a derivative of the Library (because it contains portions of the Library), rather 
than a "work that uses the library". The executable is therefore covered by this License.

Section 6 states terms for distribution of such executables.

When a "work that uses the Library" uses material from a header file that is part of the 
Library, the object code for the work may be a derivative work of the Library even 
though the source code is not.
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Whether this is true is especially significant if the work can be linked without the 
Library, or if the work is itself a library. The threshold for this to be true is not precisely 
defined by law.

If such an object file uses only numerical parameters, data structure layouts and 
accessors, and small macros and small inline functions (ten lines or less in length), then 
the use of the object file is unrestricted, regardless of whether it is legally a derivative 
work. (Executables containing this object code plus portions of the Library will still fall 
under Section 6.) Otherwise, if the work is a derivative of the Library, you may distribute 
the object code for the work under the terms of Section 6.

Any executables containing that work also fall under Section 6, whether or not they are 
linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or link a "work that 
uses the Library" with the Library to produce a work containing portions of the Library, 
and distribute that work under terms of your choice, provided that the terms permit 
modification of the work for the customer's own use and reverse engineering for 
debugging such modifications.

You must give prominent notice with each copy of the work that the Library is used in it 
and that the Library and its use are covered by this License. You must supply a copy of 
this License. If the work during execution displays copyright notices, you must include 
the copyright notice for the Library among them, as well as a reference directing the 
user to the copy of this License. Also, you must do one of these things: a) Accompany 
the work with the complete corresponding machine-readable source code for the 
Library including whatever changes were used in the work (which must be distributed 
under Sections 1 and 2 above); and, if the work is an executable linked with the Library, 
with the complete machine-readable "work that uses the Library", as object code and/
or source code, so that the user can modify the Library and then relink to produce a 
modified executable containing the modified Library. (It is understood that the user 
who changes the contents of definitions files in the Library will not necessarily be able 
to recompile the application to use the modified definitions.) b) Use a suitable shared 
library mechanism for linking with the Library. A suitable mechanism is one that (1) 
uses at run time a copy of the library already present on the user's computer system, 
rather than copying library functions into the executable, and (2) will operate properly 
with a modified version of the library, if the user installs one, as long as the modified 
version is interface-compatible with the version that the work was made with.

c) Accompany the work with a written offer, valid for at least three years, to give the 
same user the materials specified in Subsection 6a, above, for a charge no more than 
the cost of performing this distribution. 

d) If distribution of the work is made by offering access to copy from a designated 
place, offer equivalent access to copy the above specified materials from the same 
place.

e) Verify that the user has already received a copy of these materials or that you have 
already sent this user a copy.

For an executable, the required form of the "work that uses the Library" must include 
any data and utility programs needed for reproducing the executable from it. However, 
as a special exception, the materials to be distributed need not include anything that is 
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normally distributed (in either source or binary form) with the major components 
(compiler, kernel, and so on) of the operating system on which the executable runs, 
unless that component itself accompanies the executable.

It may happen that this requirement contradicts the license restrictions of other 
proprietary libraries that do not normally accompany the operating system. Such a 
contradiction means you cannot use both them and the Library together in an 
executable that you distribute.

7. You may place library facilities that are a work based on the Library side-by-side in a 
single library together with other library facilities not covered by this License, and 
distribute such a combined library, provided that the separate distribution of the work 
based on the Library and of the other library facilities is otherwise permitted, and 
provided that you do these two things: a) Accompany the combined library with a copy 
of the same work based on the Library, uncombined with any other library facilities. 
This must be distributed under the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that part of it is a work 
based on the Library, and explaining where to find the accompanying uncombined 
form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the Library except as 
expressly provided under this License. Any attempt otherwise to copy, modify, 
sublicense, link with, or distribute the Library is void, and will automatically terminate 
your rights under this License. However, parties who have received copies, or rights, 
from you under this License will not have their licenses terminated so long as such 
parties remain in full compliance.

9. You are not required to accept this License, since you have not signed it. However, 
nothing else grants you permission to modify or distribute the Library or its derivative 
works. These actions are prohibited by law if you do not accept this License. Therefore, 
by modifying or distributing the Library (or any work based on the Library), you 
indicate your acceptance of this License to do so, and all its terms and conditions for 
copying, distributing or modifying the Library or works based on it.

10. Each time you redistribute the Library (or any work based on the Library), the 
recipient automatically receives a license from the original licensor to copy, distribute, 
link with or modify the Library subject to these terms and conditions. You may not 
impose any further restrictions on the recipients' exercise of the rights granted herein.

You are not responsible for enforcing compliance by third parties with this License.

11. If, as a consequence of a court judgment or allegation of patent infringement or for 
any other reason (not limited to patent issues), conditions are imposed on you 
(whether by court order, agreement or otherwise) that contradict the conditions of this 
License, they do not excuse you from the conditions of this License. If you cannot 
distribute so as to satisfy simultaneously your obligations under this License and any 
other pertinent obligations, then as a consequence you may not distribute the Library 
at all. For example, if a patent license would not permit royalty-free redistribution of the 
Library by all those who receive copies directly or indirectly through you, then the only 
way you could satisfy both it and this License would be to refrain entirely from 
distribution of the Library.
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If any portion of this section is held invalid or unenforceable under any particular 
circumstance, the balance of the section is intended to apply, and the section as a 
whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other 
property right claims or to contest validity of any such claims; this section has the sole 
purpose of protecting the integrity of the free software distribution system which is 
implemented by public license practices. Many people have made generous 
contributions to the wide range of software distributed through that system in reliance 
on consistent application of that system; it is up to the author/donor to decide if he or 
she is willing to distribute software through any other system and a licensee cannot 
impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence 
of the rest of this License.

12. If the distribution and/or use of the Library is restricted in certain countries either by 
patents or by copyrighted interfaces, the original copyright holder who places the 
Library under this License may add an explicit geographical distribution limitation 
excluding those countries, so that distribution is permitted only in or among countries 
not thus excluded. In such case, this License incorporates the limitation as if written in 
the body of this License.

13. The Free Software Foundation may publish revised and/or new versions of the 
Lesser General Public License from time to time.

Such new versions will be similar in spirit to the present version, but may differ in detail 
to address new problems or concerns.

Each version is given a distinguishing version number. If the Library specifies a version 
number of this License which applies to it and "any later version", you have the option 
of following the terms and conditions either of that version or of any later version 
published by the Free Software Foundation. If the Library does not specify a license 
version number, you may choose any version ever published by the Free Software 
Foundation.

14. If you want to incorporate parts of the Library into other free programs whose 
distribution conditions are incompatible with these, write to the author to ask for 
permission. For software which is copyrighted by the Free Software Foundation, write 
to the Free Software Foundation; we sometimes make exceptions for this. Our decision 
will be guided by the two goals of preserving the free status of all derivatives of our free 
software and of promoting the sharing and reuse of software generally.

NO WARRANTY 15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO 
WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.

EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR 
OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE 
ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE LIBRARY IS WITH YOU. 
SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY 
SERVICING, REPAIR OR CORRECTION.
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16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING 
WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR 
REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, 
INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING OUT OF THE USE OR INABILITY TO USE THE LIBRARY (INCLUDING BUT NOT 
LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES 
SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE LIBRARY TO OPERATE 
WITH ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
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